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Disclaimer 
The Ramona Optics MCAM is a Gigapixel Microscope that is provided as a beta-unit for use by the user 
“AS-IS” and any express or implied warranties, including but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose are disclaimed. 
 
Licensing 
A copy of the license agreement is included along with the software package. If you have not received 
this agreement please contact Ramona Optics. 
 
All third party licenses can be found within the MCAM GUI by selecting “About” in the “Help” menu. 
 
Trademarks 
Ramona Optics® is a registered trademark of Ramona Optics, Inc.  
All other trademarks are the sole property of their respective owners. 
 
"Python®" and the Python® logos are trademarks or registered trademarks of the Python Software 
Foundation, used by Ramona Optics with permission from the Foundation. 
 
Contact 
 
Ramona Optics 
1000 West Main Street, Suite #2A 
Durham, NC 27701 
 
Phone: (919) 797-9975 
Email: info@ramonaoptics.com 
Website: ramonaoptics.com  
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Safety Warnings and Precautions 
The MCAM system should always be used in accordance with the guidelines of this manual to avoid 
risk of personal injury and/or damage to the instrument. If the MCAM system is used in a manner not 
consistent with the manner specified by Ramona Optics, Inc. in this manual, protection provided 
by the equipment may be impaired.  
 
Note the following safety warnings: 
 

 

The MCAM system is heavy (~70 lbs). Use caution when lifting. Use your legs and core 
muscles to lift the equipment, not your back. Keep the load close to your body during 
the lift. Maintain a firm grip on the load with both hands. 

 

The MCAM system is heavy. For stability, position all system hardware on a stable 
surface prior to use.  

 

Prior to moving, cleaning, or performing maintenance on the MCAM system, always 
power off and disconnect power from hardware and disconnect MCAM and MCAM 
Workstation.  

 

The MCAM is an electronic system. Do not touch any MCAM system hardware with wet 
hands. 

 

Ventilation is required for proper function of the MCAM system. Make sure to leave a 
minimum of two inches of space around all sides of the MCAM as well as the MCAM 
Workstation. 

 

MCAM system's  X, Y, and Z stages can move quickly, causing pinch hazards. To avoid 
pinch hazard, ensure hands are outside MCAM imaging chamber before operating the 
moving  MCAM stages using the provided software. 
 

 

LEDs on MCAM Fluorescence Illumination Module can become very hot after use. Do 
NOT touch any part of MCAM Fluorescence Illumination Module except for Quick 
Release Handles (see MCAM User Manual). 

 

The MCAM is an electronic device. Disconnect power prior to moving, cleaning, or 
performing maintenance. 
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Avertissements de sécurité et précautions 
Le système MCAM doit toujours être utilisé conformément aux directives de ce manuel afin d'éviter 
tout risque de blessure personnelle et/ou de dommage à l'appareil. Si le système MCAM est utilisé 
d'une manière non conforme aux indications spécifiées par Ramona Optics, Inc. dans ce manuel, 
la protection offerte par l'équipement peut être compromise. 
 
Prenez note des avertissements de sécurité suivants : 
 

 

Le système MCAM est lourd (~30 kg). Faites attention lorsque vous le soulevez. Utilisez 
vos jambes et les muscles centraux pour soulever l'équipement, et non votre dos. 
Gardez la charge près de votre corps pendant le soulèvement. Maintenez une prise 
ferme sur la charge avec vos deux mains. 

 

Le système MCAM est lourd. Pour une meilleure stabilité, placez le matériel sur une 
surface stable avant utilisation. 

 

Avant de déplacer, nettoyer ou effectuer la maintenance du système MCAM, veuillez 
éteindre le système, débrancher l'alimentation et déconnecter le système MCAM et la 
station de travail MCAM. 

 

Le système MCAM est un appareil électronique. Ne touchez aucun composant du 
système MCAM avec des mains mouillées. 

 

Une ventilation est nécessaire pour le bon fonctionnement du système MCAM. 
Assurez-vous de laisser un espace minimal de cinq centimètres autour du système 
MCAM ainsi que de la station de travail MCAM. 

 

Les platines X, Y et Z du système MCAM peuvent présenter des risques de pincement car 
elles peuvent se déplacer rapidement. Pour éviter tout risque de pincement, 
assurez-vous que vos mains sont à l'extérieur de la chambre d'imagerie MCAM avant 
d'opérer les platines à l'aide du logiciel fourni. 

 

Les LED du module d'éclairage de fluorescence MCAM peuvent devenir très chaudes 
après utilisation. Ne touchez AUCUNE partie du module d'éclairage par de 
fluorescence MCAM à l'exception des poignées de dégagement rapide (voir le manuel 
d'utilisation MCAM). 

 

Le MCAM est un dispositif électronique. Déconnectez l'alimentation avant de déplacer, 
nettoyer ou effectuer la maintenance. 
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MCAM Overview​  ​  ​  ​  
 
The Multi-Camera Array Microscope (MCAM) is a form of Gigapixel Microscope. This new class of 
instrument enables Gigapixel Microscopy and consists of 6 main components: data acquisition 
electronics, image forming optics, an illumination unit, a motion control unit, the graphical user 
interface (GUI) and the software development kit (SDK). The data acquisition electronics consists of 48 
optical sensors, each made up of 13 megapixels, arranged in a rectangular grid acquiring nearly 700 
megapixels per snapshot. The software and firmware coordinate these sensors so that they operate in 
the desired configuration. The illumination unit enables one to control both the spectral and the 
angular profile of the illumination. The GUI is provided to give users a quick way to navigate many of 
the functions of the MCAM. The software development kit (SDK) provides finer grained control over the 
MCAM 's functionality enabling more advanced acquisition through Python®. 

Technical Specifications 
Environmental Conditions 
Operating Temperature: 15 - 28 °C with ventilation 
The temperature of the MCAM should not be below that of the dew point to avoid condensation on the 
electronics. 
 

KestrelTM Specifications 
Dimensions: 460 x 360 x 360 mm (Height x Width x Depth) 
Mass (weight): 30 kg (68 lbs) 
Electrical outlets: Up to three (3) outlets for the MCAM, Computer, and Monitor Display. 
 

Kestrel Computer Dimensions and Specifications: 
Option 1: Desktop Computer 
Dimensions: 500 x 395 x 525 mm (Depth x Width x Height) 
Mass (weight): 14 kg (30 lbs)  
Shipping weight: 70 lbs 
Nominal power consumption: 400 W. 
Maximum power consumption: 850 W. 
Nominal power draw during usage: 300 W to 500 W. 
 
Option 2: Workstation Laptop  
Dimensions: 300 x 400 x 30 mm (Depth x Width x Height) 17 Inch Monitor diagonal 
Mass (weight): 3 kg (6.65 lbs)  
Nominal power consumption: 100 W. 
Maximum power consumption: 300 W. 
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Nominal power draw during usage: 150 W 
 
Option 3: Network attached computer 
Dimensions: Integrated into MCAM 
Nominal power consumption: 40 W. 
Maximum power consumption: 100 W. 
Nominal power draw during usage: 80 W 
 
Transmission Illumination Wavelengths 
Visible: Red -- 620 nm, Green -- 518 nm, Blue -- 470 nm 
Infrared: 850 nm 

Equipment Ratings 
 
The MCAM system is rated for use in the following conditions: 

●​ Indoor use 
●​ Altitude up to 2000 m 
●​ Temperature 15-28 °C 
●​ Maximum relative humidity 80% for temperatures up to 31 °C decreasing linearly to 50% 

relative humidity at 40 °C 
●​ MAINS supply voltage fluctuations up to +/-10% of the nominal voltage 
●​ Short duration overvoltages occurring on the MAINS supply 
●​ Only non-conductive pollution (solid, liquid, or gaseous foreign matter that may produce a 

reduction of dielectric strength or surface resistivity), except that occasionally a temporary 
conductivity caused by condensation is expected 
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MCAM  Features 
MCAM Kestrel (2022 Revision) 

 
Fig 1: MCAM  Isometric View (Left) and Rear View (Right) with key features highlighted. 

 

1)​ Stage 
2)​ Z-axis motor 
3)​ Transmission Illumination Source 
4)​ Reflection Illumination Source 
5)​ Power Indicator Light 

6)​ Power Switch 
7)​ Power Socket 
8)​ USB-B Port 
9)​ Trigger In Port 
10)​ Trigger Out Port 
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MCAM Kestrel (2024 Model) 

 
Fig 2: MCAM  Isometric View (Left) and Rear View (Right) with key features highlighted. 

 
1)​ Stage 
2)​ Z-axis motor 
3)​ Transmission Illumination Source 
4)​ Reflection Illumination Source 

 

5)​ Trigger In Port 
6)​ Trigger Out Port 
7)​ Power Socket 
8)​ Power Switch 
9)​ USB-B Port 
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Getting Started with the Kestrel 

Recommended Hardware 
 
The following hardware items are included with the MCAM system: 
 

Item Qty 

Multi-Camera Array Microscope (MCAM)  
 
Includes Kestrel Reflection Illumination Module (Qty: 1) 

1 

MCAM Workstation 
Note: Linux based workstation to ensure optimal system functionality. For more 
information on system specifications, please refer to Appendix A. 

1 

Computer Monitor, either: 
●​ Dell 24 Monitor - P2422H - Full HD 1080p, IPS Technology, ComfortView Plus 

Technology (see on Amazon), OR 
●​ Dell 27 Monitor - P2722H - Full HD 1080p, IPS Technology, 8 ms Response Time 

(see on Amazon) 

1 

Mouse 1 

Keyboard 1 

Display Cable (HDMI or DisplayPort) 1 

Universal Power Cable (3-prong NEMA, rated for 100-240VAC, 10A-5A, 47-63 Hz) 
 
Note: Universal Power Cables (3-prong NEMA, rated for 100-240VAC, 10A-5A, 47-63 Hz) are 
rated for MCAM and MCAM Workstation power supplies. Do not connect other cable types 
to the MCAM system. 
 
Note: To ensure proper grounding, only Universal Power Cables (3-prong NEMA, rated for 
100-240VAC, 10A-5A, 47-63 Hz) can be used with the MCAM system. Do not use other cable 
types with the MCAM system. 

3 

USB Cable (USB-A to USB-B) 1 

Mini SAS Cables 4 

Transmission Illumination Diffuser 1 
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Universal Stage Insert 1 

Tokai Hit ThermoPlate TPi-SQX Insert (Optional) 1 

 
The following software is included with the MCAM system: 
 

Item Description 

MCAM User Interface User interface for controlling the MCAM Kestrel Unit 
and capturing data.  

MCAM Viewer  Viewing software for data captured on the MCAM 
Kestrel. For optimal performance, it is 
recommended the MCAM Viewer be run on a 
computer with the following specs: 

●​ Ubuntu 22.04 or Windows 10 
●​ A modern Intel i7, Xeon processor, or Ryzen 

(from the last 3 years) 
●​ 16 GB of RAM (64 GB recommended) 
●​ An internal solid state drive for data storage 
●​ A dedicated graphics card 

Using an external hard drive can significantly reduce 
data transfer rates and system performance. 

Software Package License  

Ramona Optics Software Authentication Token  

 
MCAM software is continuously updated. For information on changes and update instructions, please 
refer to the changelog: https://docs.ramonaoptics.com/changelog.hl  
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Technical Support 
 
For technical and/or service issues please contact Ramona at help@ramonaoptics.com. 
 
Please feel free to ask Ramona any other questions not resolved by this manual or to request 
additional material regarding the MCAM. We can be reached by email at info@ramonaoptics.com and 
by phone at +1 (919) 797-9975. 
 
 
Website: www.ramonaoptics.com 
Address: You may reach us by mail at the following address​
 
​ Ramona Optics  

1000 West Main St. Suite 2A 
  ​ Durham, NC 27701, United State of America 

Equipment Maintenance and Service 

Servicing the MCAM  
 
For the safety of MCAM system hardware, only Ramona service technicians should service the MCAM 
system. Users should not attempt to service their MCAM systems.  
 
To avoid risk of shock or burns, as well as damage to the equipment, Ramona service technicians 
should confirm that both the MCAM and the MCAM workstation are powered off before servicing. 
 
To verify the safety state of the equipment after servicing, Ramona service technicians should 
successfully complete functionality testing, exercising MCAM system components as a user would. 
Functionality testing will include the exercising of any system stages and illumination components, 
and capturing video and image data in the formats commonly utilized by users.   
 

Cleaning and Decontamination 
 
Instructions for surface cleaning and decontamination (can be performed by any users of the MCAM 
system) are as follows. 
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Step Action 

1 Confirm that the power button at the back of the unit is in the OFF position (0). 

2 Confirm that the MCAM Workstation is powered off. 

3 Prepare a fresh 70% ethanol disinfectant solution and pour it into a spray bottle.  

4 Spray all exterior surfaces of MCAM with ethanol disinfectant solution. 
Spray any handles on MCAM with ethanol disinfectant solution. 

5 Let disinfectant sit on sprayed surfaces for 20 minutes. Surfaces should appear wet for the 
full 20 minutes. Re-wet surfaces that begin to dry before the end of this time period. 

6 After waiting for 20 minutes, use paper towels to wipe down all sprayed surfaces and 
discard towels as biohazard waste. 

 
Cleaning and decontamination of the MCAM system interior should only be performed by a Ramona 
technician. If equipment requires interior cleaning or decontamination, please contact technical 
support at Ramona Optics. help@ramonaoptics.com  
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Kestrel Installation 
 
A Ramona technician will always perform installation for MCAM systems.  
The safety of any system incorporating an MCAM system is the responsibility of the assembler of that 
system. 
 

Step Action 

1 Position the MCAM, MCAM Workstation, Computer Monitor, Keyboard, and Mouse on a 
stable surface with minimal vibration. Do not position MCAM system components in a 
manner that makes power buttons difficult to access.  

2 Confirm that the power button at the back of the unit is in the OFF position (0). 

3 Confirm that the MCAM Workstation is powered off. 

4 Plug the MCAM, MCAM Workstation, and Computer Monitor  into standard 120 V/220 V wall 
power outlets using the Universal Power Cables (3-prong NEMA, rated for 100-240VAC, 
10A-5A, 47-63 Hz). 
 
Note: Universal Power Cables (3-prong NEMA, rated for 100-240 VAC, 10A-5A, 47-63 Hz) are 
rated for MCAM and MCAM Workstation power supplies. Do not connect other cable types to 
the MCAM system. 
 
Note: To ensure proper grounding, only Universal Power Cables (3-prong NEMA, rated for 
100-240 VAC, 10A-5A, 47-63 Hz) can be used with the MCAM system. Do not use other cable 
types with the MCAM system. 

5 Connect MCAM and MCAM Workstation with one (1) USB Cable (USB-A to USB-B).  

6 Connect MCAM Workstation and Computer Monitor with Display Cable (HDMI or 
DisplayPort). 

7 Connect MCAM and MCAM Workstation with Mini-SAS Cables. Note that the terminals of 
each cable are labeled with a number that corresponds to a numbered port on the MCAM as 
well as a numbered port on the MCAM Workstation. Only connect cable terminals to ports 
that are numbered correspondingly. 

8 Connect keyboard and mouse to computer. 

9 Run stitching, sensor, pixel calibration scripts to finish setting up the system. 
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Boot Procedure 
 
Once the system has been assembled, start the MCAM in the following order: 
In the following order: 
Power on the monitor. 
Power on the MCAM unit 
Power on the computer. 

a.​ The default username and password are: 
i.​ Username: ramona 

ii.​ Password: gigapixel 
 
Note: The MCAM must be powered on before the workstation computer to open and use the MCAM 
software. If the computer is on and MCAM is off, please turn on the MCAM and then reboot the 
computer prior to use. If the system is not powered on in this order, the MCAM will return an error 
message upon opening and will not function. 
 
Once the system has been started for the first time, it is possible to turn off the MCAM while leaving the 
computer on. It will simply have to be turned on again prior to using the MCAM software. 
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Kestrel Reflection Illumination Module 
 
The Kestrel Reflection Illumination Module allows the user to illuminate samples from above. To set up 
the Kestrel Reflection Illumination Module within the MCAM system, complete the following steps. 

 
Fig 3: Kestrel Reflection Illumination Module 
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Fig 4: MCAM chamber upper interior surface with lens block 

 

Step Action 

1 Remove the Kestrel Reflection Illumination Module from its packaging, taking care to only 
touch it by the quick release handles on either end of the module. 
 
Note: To protect the hardware of the Kestrel Reflection Illumination Module, never touch 
any part of the module except the quick release handles. 
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Note: Surfaces of Kestrel Reflection Illumination Module can become hot after use. To 
avoid risk of burns, use caution when touching module after use. Do not touch any part of 
module except for quick release handles. 

2 Simultaneously pressing down on the button on each of the Kestrel Reflection 
Illumination Module’s 2 quick release handles, insert the module’s pins into the sockets on 
either side of the MCAM lens block on the upper interior surface of the MCAM chamber. 
 
Make sure to insert the Kestrel Reflection Illumination Module so the end with the cabling 
is near the Kestrel Reflection Illumination Module Ports on the right hand side of the 
MCAM 

 

3 Releasing the buttons on the Kestrel Reflection Illumination Module quick release 
handles, connect the cable on the module’s back rail to the upper  Kestrel Reflection 
Illumination Module Port. Connect the cable on the module’s front rail to the lower  
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Kestrel Reflection Illumination Module Port. 

4 Now, plug the USB cable from the control box to the workstation and connect the provided 
AC power cable between the control box and an AC power outlet.  In the MCAM  GUI 
software, Fluorescence is located in the left panel with the rest of the acquisition controls. 
Select the excitation wavelength to use and type or select the power with the slider. Use the 
enable checkbox to turn the LEDs on or off.  
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Driving the LEDs for extended periods of time and at high power levels could cause the LEDs to 
overheat.  This will result in the LEDs turning off automatically. It is recommended that the 
Fluorescence be turned off when not in use and, when in use, the power be kept below 50% whenever 
possible to reduce the likelihood of overheating.  (See Fluorescence Illumination Modules Turned Off 
or Not Turning On Troubleshooting section for more details) 
 
The Kestrel Reflection Illumination Modules may be used as reflection illumination modules if they are 
equipped with white or IR 850 nm LEDs. 

Viewing Data Acquired by the MCAM 
 
The images acquired by the MCAM can be viewed in a variety of ways: 

1.​ Per-micro camera images: Data can be exported on a per-micro camera level allowing them 
to be viewed and analyzed in isolation. A metadata file includes information about the MCAM 
system that was used to acquire the images in a machine readable format. 

2.​ Stitched image of the entire FOV: Data can be exported using the GUI into a single stitched 
image. This is most appropriate for publication quality images. Unfortunately, many image 
viewers struggle to load images more than 100 megapixels in size, limiting the use of this 
image format. 

3.​ NC of the original data: The standard NC files that are used throughout the MCAM software 
retain the original data. This data can be loaded into other applications such as Python and 
Matlab, but requires users to apply many of the corrections applied in the MCAM Viewer 
application. For more information about the dataset, please refer to our documentation found 
online: https://docs.ramonaoptics.com/python_metadata.hl 
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MCAM Viewer Installer 
 
All required software has been installed on the provided MCAM workstation prior to delivery.  
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Kestrel 

Graphical User Interface (GUI) 

Opening and Closing the MCAM 
 
After installing the acquisition software, and turning on the MCAM, the Graphical User Interface (GUI) 
can be started by clicking on the Ramona Optics  application launcher on the sidebar. By default,  the 
MCAM will attempt to connect to each of three components:  

●​ The reflection illumination board,  
●​ The transmission illumination board, 
●​ The stage motor. 

If any of these components are unavailable, the user can choose to not connect these components by 
deselecting their boxes in “Select Components” under the “Advanced” menu on the toolbar. This will 
automatically disable the ability to change the settings for these components. 
 
The MCAM can be closed using the “Exit” button from the File menu,  or by exiting the GUI with the red 
“X” button in the upper right corner. Either method will stop all ongoing operations and safely close 
the MCAM. 
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Fig 5: GUI start screen, with the “File” menu open and highlighted. 

GUI Navigation 
 
The user can zoom and pan in the GUI to view any section of the streamed or acquired images. To 
zoom, either scroll up and down on the mouse wheel, or move the mouse while holding the right click 
mouse button. To pan, move the mouse in any direction while holding down the left click button. 
 
At the top left of the window (Fig 6, #1) the current file location is displayed. This is the location where 
all files will be saved.  
 

 
Fig 6:  GUI layout with 1) Selected file location, 2) Image Acquisition Mode Buttons, 3) Image Acquisition Settings Panel, 4) Picture-in-picture 

and 5) Key Image Specifications highlighted. 
 
At the top left of the window (Fig 6, #2) the Image Acquisition Mode Buttons allow the user to select 
what area under the microscope they want to image. The following are the functionalities provided:  

-​ Stream All Sensors: allows users to see everything happening under the microscope. 
   

-​ Select Active Sensors: allows users to select certain camera sensors to record from a specific 
area of interest. You can either select just one sensor by simply moving the cursor around, the 
display will be bright around the area covered by that one sensor and have shadows on the 
remaining area, or you can select several sensors. For selecting several sensors the first click of 
the user cursor will define the beginning of the area that will be recorded, a selection box will 
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pop up which can be expanded/reduced by moving the cursor and finally the second click will 
define the end of the area (Fig 7). 
 

 
Fig 7: Streaming from certain selected sensors.  

 
-​ Stream Active Sensors: allows users to see everything happening under the area they selected 

using the Select Active Sensors function. 
 
The image acquisition settings panel is on the left side of the viewing window (Fig 6, #3). 
 
While panning, the picture-in-picture (Fig 6, #4) in the right-hand corner of the screen shows what 
portion of the full image is currently displayed.  
 

 
Fig 8: Key Image Specifications 

  
Some key image parameters are displayed at the bottom of the viewing window (Fig 6, #5 and Fig 8) 
including a scale bar providing an approximate scale. Note that the scale bar assumes a constant 
width for each pixel, and may not be accurate across the entire sample if 3D features are present. 
Additionally on the right side, RGB color values of the LEDs are displayed which have been preselected 
using calibration data. 
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MCAM Settings 
 
Most of the MCAM Settings can be adjusted using the Settings Panel on the left side of the GUI. 
 
The panel can be hidden to make more room on the screen by clicking on the white line border 
between the settings panel and the image, and sliding to the left. The GUI allows the user to set the 
system parameters within a range of values acceptable for most common experimental setups. More 
customized settings can be set in the Advanced submenu. 
 
Most settings values can be adjusted either by using the sliders or by directly typing a value into the 
text box. When using the text box, the accepted values will still be limited to the maximum and 
minimum values shown on the respective slider. In addition, the setting displayed in the text box may 
adjust to a value slightly higher or lower than the value entered. This is because for  certain  settings  
(particularly  digital  and  analog  gain),  the  MCAM  can  only  accept  distinct values. The GUI will 
automatically round the entered setting to the nearest acceptable value, and send that parameter to 
the MCAM system. 

Loading/Saving Settings 
On first use, the GUI will load a set of predetermined default settings which were chosen to produce 
generally high quality images. Afterwards, the GUI will automatically load the settings from its last use. 
Because each unique imaging environment and sample may have different optimized settings, the 
settings for individual experiments can be saved and loaded using the “File” menu in the toolbar, 
selecting “Save Settings” within it. The default settings can also be re-loaded using the “Restore 
Default Settings” button in the same menu. 

Image Acquisition Settings 
The sensor exposure, gains, and LED parameters can all be set from the setting panel on the left side of 
the GUI, as well as contrast levels of the displayed image. These settings are further explained below. 
 
Exposure: This setting controls the amount of time that the camera sensor acquires light for each 
frame. A longer exposure will yield a brighter image with more motion artifacts while shortening the 
exposure will darken the image with fewer motion artifacts. Additionally this setting will affect the 
framerate when using streaming acquisition modes with longer exposures decreasing potential 
framerate. In order to maximize framerate, consider keeping the exposure as low as possible and 
balance lighting with the brightness setting. 
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Fig 9: Camera sensor settings. 

 
Digital and Analog Gain: Gain settings will magnify the signal produced by the image sensors. Analog 
gain increases the sensitivity of the sensors using hardware while digital gain increases the signal 
using software to multiply the signal once it has been converted to a digital signal. Increasing gain 
values will increase image intensity but will also increase noise proportionally. Keeping gain values as 
low as possible will reduce inherent noise (Fig 9). 
 
Brightness: Located under “LED Settings”, this will control the overall brightness of the LEDs used to 
illuminate the sample (Fig 10). 

 
Fig 10: GUI LED board settings 

Zebrafish Panel Settings 

Vibration Stimulus 
Both the frequency and amplitude of the vibration stimulus can be controlled using the MCAM user 
interface. The desired stimulus frequency can be selected from the dropdown menu located under 
“Assays”>”Zebrafish”. As each stimulus frequency is paired with a specific stimulus amplitude 
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(documented in the lookup table below), varying stimulus frequencies will also vary stimulus 
amplitude. Use the lookup table below to control the amplitude of the vibration stimulus. 
 
 

Vibration Stimulus Frequency-Amplitude 
Lookup Table for Zaber Stage 
Set-X-LSM200A-D12-ENG3286   

Freq (Hz) Amplitude (μm) 

250 1 

300 0.25 

300 0.5-6 

300 0.75 

300 1 

350 1 

 
 

 
 

Illumination Mode Selection:  
-​ The transmission LED board: the standard light source for use with the MCAM  when imaging 

semi-transparent samples and is installed in the base of the unit. Selecting this light source, 
the stage will be lit from below and pass through the sample before reaching the camera 
sensors. The illumination options that are linked to this board are the transmission brightfield, 
darkfield and IR850 modes.  

-​ The Kestrel Reflection Illumination Module is optional and can be mounted above the stage. 
Selecting this option will light the stage from above and light will reflect off the sample before 
reaching the camera sensors. The illumination options displayed will change depending on the 
module purchased with the system. 

 
Stage Position Settings: The location of the Z-stage can be changed using either the up and down 
arrows or by manually entering a location (given in millimeters from the highest point where the stage 
can be positioned) (Fig 11) on the Z scale within the “Stage Position Panel”. Step size controls the 
increment by which the arrows will adjust the height. Adjusting the Z-stage location will move the 
stage and sample in and out of focus. X and Y position can also be adjusted in the same manner. 
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Fig 11: Z-stage settings. 

 
Gamma: Adjusting this value will control the encoded image’s sensitivity to bright and dark tones and 
is an effective method of controlling the overall image contrast as perceived by humans (Fig 12). 
Reducing Gamma will decrease shadows and darker tones yielding a brighter image. 
 

 
Fig 12: GUI contrast settings. 

 
 
Max and Min Levels: The “Max level” and “Min Level” sliders are used to set the contrast of the image 
as displayed in the GUI (Fig 12). All pixels in the raw image data with values equal or greater to the 
selected “Max Level” will be displayed using the highest pixel value, while any data pixels with values 
below the “Min Level” will show up as black. The remaining middle range of pixels will be displayed 
using the full range of display pixel values. These settings are only for immediate display, and do not 
impact the data being gathered or saved. Fig 13 shows the impact on the displayed image of changing 
the Max and Min levels.  
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Fig 13: Images with different Max and Min levels: 0 and 1 (left), 0.7 and 0.2 (center), 0.5 and 0.5 (right). 

Save and Export Images 
 
MCAM data can be exported or saved from the GUI in several ways. First, high resolution images can be 
exported using the “Save Image as NC'' or the “Save Image as Tif” buttons (Fig 14). “Save  Image as 
NC'' will  save  the  full  resolution  MCAM  data  in  a  single  “ .nc”  file  which  can be opened for 
analysis in the Ramona Optics custom MCAM Image Viewer or in MathWorks software. “Select File 
Location” will open the directory in which the most recently saved images were placed. 
 

 
Fig 14: Save settings. 

 
“.nc” files use the netcdf4 data format. More information on the implementation and usage of this file 
structure can be found here: https://unidata.github.io/netcdf4-python/ 
 
Saved images are given a filename according to the following rules: 

1.​ The user defines the prefix of this filename by entering in the “Image Name” field (Fig 
14).  
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2.​ The suffix of this filename is generated as a timestamp with the following format​
YYYYMMDD_HHMMSS_mmm where: 

○​ YYYY is the year when the image is saved, e.g. 2020. 
○​ MM is the month when the image is saved, e.g. 08. 
○​ DD is the day when the image is saved, e.g. 06. 
○​ HH is the hour (in 24 hour format) when the image is saved, e.g. 15. 
○​ MM contains the minute when the image is saved, e.g. 43. 
○​ SS contains the seconds when the image is saved, e.g. 52. 
○​ mmm contains the milliseconds when the image is saved, e.g. 549. 
○​ The final timestamp will appear as: 20200806_154352_549 

Notes can be entered in the “Additional Information” field which are saved with the image file and 
displayed in the MCAM Viewer with the image. 
 
Low resolution screenshots of the currently displayed images can be saved using “Capture 
Screen-shot” in the “File” menu of the toolbar. This screenshot will include the main canvas, as well as 
the picture-in-picture and the main settings (see Fig 15). 

 
Fig 15: Screenshot of GUI Images 

 
Note: If a filename is entered in the “Image name” field and the workspace is changed, the filename 
will be deleted and the user will need to enter a new filename.  
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Save Video or Z-Stack 
 
To take and save a video or Z-stack, open the Assays window by selecting the “Assays” menu. Select 
either “Acquire Video”  or “Acquire Z-stack” within it. A panel on the right side of the screen will pop up 
(Fig 13, Fig 14) and the user can start by entering a filename and any pertinent notes in the “Additional 
Information”. 
 
When acquiring videos, the number of frames corresponds to the selected exposure time in the main 
window. For example, if the exposure time is set to 200 ms, a 10 frame video will be 2 s long (Fig 16). 
When acquiring Z-stacks the step size as well as bounds can be manipulated as shown in Fig 17. 
 

 
Fig 16: Advanced Functions Window with Video settings.  
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Fig 17: Advanced Functions Window with Z-stack settings. 

 

Annotation Tools  
 
Within the MCAM GUI and Viewer image annotation tools are provided to assist with image analysis. 
These tools can be accessed from the “Tools” menu in the toolbar (Fig 18). 
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Fig 18: Tools menu 

 

Color Picker 
When the Color Picker tool is selected, clicking on the screen will display the pixel color at this 
location. Values are displayed as (Red, Green, Blue) integers corresponding to the three color channels 
of the image (Fig 19). 
 

 
Fig 19: Example of color picker function on zebrafish image. 

 
It is important to note that pixel values displayed on the screen are subject to color corrections and the 
viewing color space. Under the “View” menu in the toolbar, the color space can be adjusted which will 
alter the displayed values (Fig 20). In the below example, the color space has been changed from RGB 
to Grayscale and the RGB values all display the same color channel (Fig 21). 
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Fig 20: View menu 

 
Fig 21: Example of View menu application to image referenced in Fig. 19 
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Length Tool 
When the Length Tool is selected, straight lines can be measured on the screen (Fig 22). Clicking once 
with the left mouse button and once with the right mouse button places two points on the screen and 
a straight line is drawn between them. The length of the line is displayed on the screen. This 
computation requires an accurate pixel width calibration to convert from units of pixels to millimeters. 
 

 
Fig 22: Length tool 

 

Advanced Settings  
 
Additional settings can be found in the “Advanced” menu and are described below (Fig 23). 
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Fig 23: Advanced Menu 

 
Stitch Image 
The individual images can be displayed in the GUI as stitched or unstitched (Fig 24). The full image is 
stitched using a calibration file specific to the individual MCAM setup (see System Calibration), which 
the GUI automatically loads and uses to place the images in the GUI canvas. If the image is un-stitched, 
the central square from each imaging sensor will be displayed with a small border between them. 
Whether the image is stitched or unstitched makes no impact on the GUI performance.  
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Fig 24a: GUI with stitched image. 

 
Fig 24b: GUI with unstitched image. 

 

Interpolate 
Checking this allows the user to see a smooth image when zooming in to levels that would otherwise 
be shown as pixelated. 
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Color Corrections 
Checking this box applies sensor corrections calculated during system calibration. The default state for 
this setting is active. 
 
Blend Images 
Checking this reduces the visibility of seam between stitched images, but may cause shadowing if 
features from overlapping images do not line up perfectly. 
 
Software White Balance 
Checking this compensates for the sensor's uneven responsiveness to red, green and blue when 
imaging in brightfield (white) light. 
 
Show Image Labels 
Checking this provides an overlay to display the well in each camera, if a well extracted dataset, or the 
label of the sensor that acquired the image. 
 
Show Overview 
Checking this shows the overview image in the top right of the screen to help keep track of the current 
view of the image scene. Predefined sizes of the overview window can be applied by clicking Small 
Overview or  Large Overview, or the overview window can be adjusted by clicking on the edge of the 
overview window. 
  
Show Scale Bar 
Checking this will make a scale bar appear in the picture-in-picture panel.  
 
Show Acquisition Information 
Checking this will make the key image specifications (height, exposure, analog gain, digital gain, 
brightness and temperature) appear in the picture-in-picture panel.  
 
Show Logo 
Checking this will make the ramona logo appear in the picture-in-picture panel.  
 
Dark Mode 
Checking this allows the user to see the dark mode of the interface, meaning that elements will be 
presented in darker colors and the background of the picture-in-picture panel will be black instead of 
white.  
 
Additional Settings 
The additional settings window allows the user to set the minimum and maximum values that the GUI 
will accept for the exposure and gain settings (Figure 25).  
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Fig 25: Additional Settings Window. 
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MCAM Viewer 
The MCAM Viewer software allows for viewing images that have been previously acquired and saved 
using the MCAM  GUI.  
 
The MCAM Viewer software is provided as a distributable executable (see MCAM Viewer Installation) 
and can be run using Linux systems. Compatible file types include “.nc” files which use the netcdf4 
data format as well as “.png”, “.tif” and “.bmp” images.  
 
In the MCAM Viewer, image contrast can be adjusted using the Gamma, Minimum Level and Maximum 
Level settings in the bottom left corner. Metadata that has been saved with image files is displayed on 
the left side of the viewer window. Additionally, functionality similar to the GUI is available including 
the(see Graphical User Interface for more information) (Fig 26). 

 
Fig 26: MCAM Viewer Window. 
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Video Playback 
 
The MCAM  Viewer allows for video playback with multiple settings affecting playback speed.   

-​ Frame Skip allows the user to specify an interval of frames that will skip between frames. 
-​ Viewer FPS allows the user to request a playback FPS. This is dependent on the amount of data 

in each frame. 
-​ Viewer FPS will be limited to 60 therefore if the recording is done at a greater FPS Frame Skips 

need to be added to be able to visualize the video at the speed at which it was recorded. 
Combining these options allows for a user to reach a higher effective FPS than otherwise possible (Fig 
27). 

 
Fig 27: Video playback settings  

44/142 

 
Ramona Optics - MCAM User Manual 



 

MCAM Data Analysis 
 
Documentation of our Python API with examples is available at docs.ramonaoptics.com. 

Acquisition Considerations 

Recommended Video Acquisition Parameters 
For behavior analysis and motion tracking we recommend the following imaging parameters in “High 
Frame Rate” mode: 
 

●​ Transmission Illumination:​ Transmission IR850 
●​ Exposure:​ ​ ​ ​ 2 milliseconds 
●​ Brightness:​ ​ ​ ​ 60% 
●​ Digital Gain:​ ​ ​ ​ 2.0 
●​ Analog Gain:​ ​ ​ ​ 1.0 

 
A settings file to load the recommended imaging parameters for behavioral analysis is located HERE 
for download. 
 
For eye analysis, data must be captured in either “Standard(bin x2)” or “High Resolution” mode in 
order to properly resolve the shape of the eyes. We recommend the following imaging parameters in 
“Standard (bin x2)” mode: 
 

●​ Transmission Illumination:​ Transmission IR850 
●​ Exposure:​ ​ ​ ​ 2 milliseconds 
●​ Brightness:​ ​ ​ ​ 60% 
●​ Digital Gain:​ ​ ​ ​ 2.0 
●​ Analog Gain:​ ​ ​ ​ 1.0 

 
For morphology analysis we recommend the following imaging parameters in “High Resolution” 
mode: 
 

●​ Transmission Illumination:​ Transmission Brightfield 
●​ Exposure:​ ​ ​ ​ 10 milliseconds 
●​ Brightness:​ ​ ​ ​ 30% 
●​ Digital Gain:​ ​ ​ ​ 1.0 
●​ Analog Gain:​ ​ ​ ​ 1.0 

 

45/142 

 
Ramona Optics - MCAM User Manual 

http://docs.ramonaoptics.com
https://drive.google.com/file/d/191eAdwOH7mePv3Dm4TDEpld35k--pXCg/view?usp=share_link


 

Z-height must be set initially by the user to focus and properly resolve the image. This parameter is 
unit specific. 
 
Infrared illumination is generally used in behavioral imaging experiments because zebrafish do not see 
wavelengths in the infrared spectrum and thus the lighting does not change their behavior. For some 
behavioral experiments such as prey capture and hunting behavior experiments, visible RGB spectrum 
lighting may be necessary so that zebrafish can see their prey. 
 
Frame rate is an important parameter to consider and is likely specific to each experiment. For general 
use we recommend setting the frame rate to 120 frames per second (fps) however in some cases 160 
fps may be achievable while for longer (>5 minute) durations, recordings may be limited to 30 fps. 
Please contact us for assistance in tuning this value for your experiment. 
 
The captured dataset, containing both the video, and metadata relating to the experiment can be 
opened in the MCAM Viewer by drag-and-dropping the file into the Viewer window or by selecting “File 
> Load Settings” from the menu bar. 

Imaging Modes and Pixel Binning 
The MCAM acquires video data in three different imaging modes: “High Resolution”, “Standard (bin 
x2)”, and “High Frame Rate”. The mode can be selected in the drop down menu in the top left corner of 
the  GUI (Fig 28). 
 

 
Fig 28: Imaging modes 

 
In High Resolution mode all pixels in the camera sensor are activated and streamed. In Standard 
resolution mode, pixels are binned by two, meaning every other pixel is skipped and thus half of the 
pixels are streamed over the full sensor, halving the resolution. In High Frame Rate Mode, one in every 
four pixels is streamed so the resolution is reduced by a factor of four. The benefit of these imaging 
modes is that by streaming less data at one time, frame rate can be increased almost linearly. ​
 

Movement Blur: Frame-Rate vs. Exposure 
Both frame-rate and exposure are important parameters to optimize. Reducing exposure means 
decreasing the amount of time the camera's sensor is exposed to light resulting in less light entering 
the camera and hitting the sensor, which can reduce motion blur. Reducing the exposure time also 
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means that less light is entering the camera, which can result in an underexposed image. To 
compensate for this, the brightness of the MCAM is increased. Increasing frame rate gives you more 
chances of capturing each body position within a movement however increasing frame-rate also 
increases overall data size and should be monitored closely. 

Sensor Shape for Frame-Rate Optimization 
Video frame rate can be optimized by changing the camera sensor size. This is done by cropping which 
pixels are streaming from each camera sensor as it acquires frames. Each camera has 3136 x 4224 
pixels total. Most images with a behavioral MCAM can be best acquired with a 3072 x 3072 or 2048 x 
2048 pixel field of view. Specifically 24- and 96-well plates can be imaged with the smaller image shape 
to increase frame-rate to 160 fps. 48-well plates require a field of view of 3072 x 3072 pixels to capture 
all wells on the well plate which allows a maximum of 120 fps acquisition. To change the sensor shape: 
 

1)​ Select “Additional Settings” Advanced menu on the toolbar, pictured below (Fig 23, Fig 29). 
 

 
Fig 29: Advanced menu, additional settings panel 

 
2)​ In the bottom section “Per sensor acquisition area”, select the desired field of view.  
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Video Compression 
 
The first step of all analysis pipelines is to compress the raw “.nc” file dataset to an mp4 video and 
accompanying metadata. To accomplish this task, a Well Alignment Keypoint file must be created, 
specific to each MCAM unit and well plate being used. This file simply describes the location of the 
center and radius of each well within each image captured. This file only needs to be created once 
assuming there are no changes to the physical setup of an experiment. If the stage moves from side to 
side or the well plate in use is modified, a new keypoint file may be necessary. 

Creating a Keypoint File 
1)​ To create a new Keypoint file, open a .nc file in the MCAM Viewer and open the “Well 

Alignment” panel from the “Tools” menu on the menu bar (Fig 19). 
 

2)​ Input the number of columns and rows corresponding to the well plate in use. 96-well plates 
have 12 columns and 8 rows, 48-well plates have 8 columns and 6 rows, and 24-well plates 
have 6 columns and 4 rows as shown below. For machine learning tracking the diameter 
value is specific for each tracking model and for proper tracking and analysis 
functionality it is required to enter 1024 pixels for 96-well, 1408 pixels for 48-well, and 
2048 pixels for 24-well. The exact diameter in millimeters will update automatically and may 
vary slightly between systems depending on the calibrated pixel width (Fig 30). 

 

 
Fig 30: Well Alignment panel 
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3)​ Once the correct parameters have been entered into the required fields, click “Detect Well 
Alignment”. 
 

4)​ When initially detecting well keypoints it is likely this step will fail as shown below with circle 
indicators not lining up with wells. This is expected (Fig 31). 

 

 
Fig 31: Well Alignment initial guess. 

 
 

5)​ To correct this initial guess, only the four corners must be repositioned. Double click on the 
center point of a corner circle and drag the circle over a corner well until it lines up with the 
outer edge of the well. This is shown in the top left corner of the image below (Fig 32). 
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Fig 32: Well Alignment corrected initial guess. 

 
6)​ Once the four corner well indicators are aligned with the corner wells, click “Update Well 

Alignment” from the right panel to reposition the remainder of the indicator circles (Fig 33). 
 

 
Fig 33: Well Alignment panel with “Update Well Alignment“ option. 
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7)​ Ensure that well indicator circles and center points are correctly aligned with each well (Fig 

34). Individual adjustments can be made if necessary by again double clicking on the center 
point of each red circle, and dragging to the correct location. 

 

 
Fig 34: Fully aligned Well Alignment. 

 
8)​ Select “Save Well Alignment” from the right panel. 

 
9)​ Select a save location and file name for this “.json” file. We recommend file names with a date 

and/or experiment description as well as the well plate type (Fig 35). 
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Fig 35: Format for saving well alignment.  

 

Square Well Plate Keypoints 
When using a 96 square well plate, the above procedure should be followed similarly, starting with 
selecting the Square Well option which will result in square well indicators (Fig 36).  
 

 
Fig 36: Well Alignment for square well plates. 

Compress the Video 
Prior to analysis, the raw (.nc) data format acquired by the MCAM must be compressed to a mp4 file 
format. Video compression allows for reduced data sizes while still maintaining data fidelity. 
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1)​ Open the “Compress Video” panel within the “File” menu (Fig 37). 

 

 
Fig 37: File menu. 

2)​ Click “Select Alignment File” and select the well keypoints file corresponding to the well plate 
in use that was saved previously (Fig 38a). If the file has already been aligned then this will not 
be available and the compression can be run without this step (Fig 38b). 

 

 
Fig 38a: Panel for dataset compression with alignment option. 
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Fig 38b: Panel for dataset compression without alignment option. 

 
Note the blue circles that appear, marking where the wells will be extracted and compressed. Well 
alignment cannot be changed from this panel (Fig 39). 
 

 
Fig 39: Well alignment overlay shown before final video compression. 
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3)​ Click compress and the compressed mp4 dataset with chosen export suffix will be saved in a 
new folder in the same directory as the original .nc file (Fig 40). 

 

 
Fig 40: File format compression results will save as. 

 
4)​ Multiple files can be compressed at once by clicking the “Batch Analysis” checkbox and adding 

more files to the queue. Note that all files to be compressed in a batch must share the same 
well alignment file (Fig 41). 

 

 
Fig 41: Batch analysis option within video compression. 
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Compression Options 
For ease of data management, and repeatable analysis, we recommend compressing videos using 
H264 with the acquired video stored in a file with a mp4 extension (Fig 42). Ramona Optics has tuned 
the encoding parameters to prefer higher quality videos that are suitable for re-analysis with Ramona's 
MCAM software. Ramona will attempt, when possible, to store the entire dataset in a single mp4 with 
the metadata stored in a file called metadata.nc. To maximize the quality of the videos, compression 
ratio, and analysis speed, all datasets are compressed at a fixed frame rate of 30 frames per second. 
This is accomplished by encoding many individual video tiles into one composite video which can be 
encoded and stored as one object as well as retrieved and played back in the MCAM Viewer efficiently. 
The default behavior of the compression panel will generate a “tiledmp4” when possible and no 
option modifications are necessary within the MCAM Viewer compression panel. 
 

 
Fig 42: Default compression options. 

 
At higher resolutions, combining many video streams together may not be possible due to software 
limitations of available video encoders. In this case one mp4 will be generated per well extracted and 
these will be stored as a “multi_mp4” dataset. For example, a dataset contains 24-well plate data 
acquired in High Resolution imaging mode with a 2048 x 2048 sensor size. If this data were encoded 
together into one tiled mp4 video, the resulting image size would be 12,288 x 8,192 pixels. Current 
video encoders reach a limit of 4096 x 4096 pixels although this limit is evolving quickly. In this case, an 
individual video will automatically be generated for each well resulting in 24- 2048 x 2048 pixel videos. 
This  dataset can still be loaded and viewed together using the MCAM Viewer by asking the MCAM 
Viewer to open the associated metadata.nc file. The user can select “Generate One mp4 per Video Tile'' 
to force the video compression on a tile by tile basis (whether this is a camera by camera basis, or well 
by well basis) as shown below (Fig 43). 

 

 
Fig 43: Compression panel option which enables users to select the option of “Generate One MP4 per Video Tile”. 
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The default video encoder (h264_nvenc) will utilize the NVidia GPU provided with the MCAM 
workstation to improve performance of video encoding.  
 
Compressed datasets (both “tiledmp4” and “multi_mp4”) can be loaded for display into the MCAM 
Viewer by either double clicking the “metadata.nc” file in dataset folder or be drag-and-dropping the 
full dataset folder into the MCAM Viewer window. 

Video Orientation 
Prior to generating the final outputs, the MCAM video data is stored in one of two classes of formats: 

1.​ In an .nc file where both the metadata and the video data are stored within the same file. 
2.​ In a folder containing an metadata.nc file for the metadata and an .mp4 file containing the 

video data to be analyzed. 
To avoid accumulated error before the final results are computed, minimal lighting and orientation 
corrections are applied to the mp4 file. Therefore, the video as played back by a standard video player 
may not appear exactly as it does in the MCAM Viewer. For datasets stored in mp4 formats, an EXIF 
orientation value of 8, as is common for MCAM Kestrels in the upright configuration, will result in an 
apparent rotation of 90 degrees in most video players. This rotation does not apply to the results 
stored in tabular format. 
 
For more information on how to use EXIF the orientation metadata in your own analysis pipelines, 
please refer to the appropriate section in the . MCAM User Manual

 

MCAM User Interface Activity Metric Analysis 

Zebrafish Embryonic Photomotor Response Assay 
The Zebrafish Embryonic Photomotor Response (EPMR) assay (Fig 44) consists of 3 recording periods, 
each separated by a light flash. The first period is the Background period, followed by the first flash. 
The second period is the Excitatory period followed by the second flash. The last period is the 
Refractory period, ending the assay. The assay records at 16 fps and defaults to sensor and 
illumination settings that are tested to work well with the analysis. The analysis is performed in 
parallel with the acquisition and computes the number of changed pixels between frames via the 
following formula: 
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Where: 

●​  is the pixel value ranging from 0 to 255 of frame i 𝑃
𝑖
(𝑥, 𝑦)

●​  is the pixel value ranging from 0 to 255 of frame i + 1 𝑃
𝑖 +1 

(𝑥, 𝑦)

●​  is a relative threshold set to .1 𝑇

●​  is an absolute threshold set to 20 𝐷

●​  is the frame height 𝑚

●​  is the frame width 𝑛
This analysis is exported as a csv with a column per each image and a row for each time point. A plot 
for each column is also exported for quick review, along with the full video dataset. These are all 
placed in the provided directory. 

 
Fig 44: Zebrafish Embryonic Photomotor Response Assay panel. 
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MCAM Viewer Activity Metric Analysis 
 
Activity metric analysis provides a rapid method for computing movement in a video. This is 
accomplished by subtracting each pair of adjacent frames in a video to quantify pixel change. All pixels 
are treated equally so while total movement is measured over time, we cannot determine “how” 
something within a frame moves. 
 
In the MCAM Viewer, Activity Analysis can be accessed from the “Assays” file menu (Fig 45, Fig 46). 
 

 
Fig 45: Assays menu. 
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Fig 46: Activity Analysis panel. 

 

MCAM Viewer Activity Metric Outputs 

Activity Metric Composite 
The activity metric composite shows an overview of total activity within each well or video tile. Values 
are displayed on a log10 scale (Fig 47). 
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Fig 47: Example of activity metric composite. 

 
 

Activity Plots 
A plot of activity over time (Fig 48a) is generated as well as a plot of cumulative activity over time (Fig 
48b). Axes are normalized to the maximum value of the overall dataset to facilitate comparison 
between wells or video tiles. 
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Fig 48a: Example plot of well activity over time. 

 
 

 
Fig 48b: Example plot of cumulative well activity over time. 
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Activity Data (.csv)  
The tabular CSV output “activity_data.csv” displays the sum of pixel differences for each frame on a 
per well basis (Fig 49). 
 

 
Fig 49: Example csv of activity data. 

 
 

MCAM Zebrafish Analysis 
Zebrafish analysis software includes 8-point tracking and morphology analysis as well as the activity 
metric analysis discussed previously. 

Machine Learning Tracking 
Zebrafish 8-point tracking with the MCAM is fully automated end-to-end across an entire well plate. 
Currently 24-, 48- and 96-well plates are supported in Visible and Infrared transmission illumination. 
Tracking relies on custom trained machine learning algorithms that label key features of interest. Our 
Zebrafish models consider eight key-points throughout the fish. These include: the Snout, Left Eye, 
Right Eye, Center-point (center of swim bladder), Caudal Fin (tail-tip), Mid-Tail (between center and 
caudal fin bisecting the previous two points), Between-Center-and-Mid, and Between-Mid-and-Caudal. 
Labeled points are shown in the figure below (Fig 50). For each key-point an x and y coordinate within 
the image are recorded with a confidence value attached. These values are output to the user as raw 
tracking data for each well in a plate as well as further analysis, visualizations and derived metrics. 
Machine learning tracking models improve over time by adding more diverse training data. 
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Fig 50: 8 points used for machine learning Zebrafish tracking. 

 
 
Once a video .nc file has been compressed, load the compressed dataset by dragging and dropping the 
entire directory into the MCAM Viewer window. Alternatively the “metadata.nc” file within this 
directory can be double clicked to open the compressed dataset. The “Zebrafish Assay” panel (Fig 51) 
can be opened within the MCAM Viewer from the “Assays > Zebrafish” > “Zebrafish Assay” menu in the 
menu bar (Fig 45). 
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Fig 51: Animal Tracking Assay panel. 

 
1)​ The well plate configuration (24-, 48-, or 96-well) will be automatically detected by the MCAM 

Viewer software.  
2)​ If square well plates are in use, check the box indicating “Square Well Plate” 
3)​ Select the output files of interest. We recommend always generating the “Raw 8-keypoint 

Model Output” which includes the raw tracking data for each well which is used in further 
analysis computation. Output files are described below. 

4)​ Click “Track Zebrafish” to begin the automated tracking analysis. 
5)​ Multiple files can be tracked and analyzed at once by clicking the “Batch Analysis” checkbox 

and adding more files to the queue. All files must be of the same well plate configuration (24-, 
48, or 96-well) and use one tracking model to be analyzed together.  
Note: to load multiple compressed datasets into the viewer for batch analysis, the entire 
dataset folder should be selected, not the “metadata.nc” file within the dataset folder. 

6)​ If “Reanalyze Previously Inferred Tracking Data” is checked, the software will find a pre-existing 
“tracking_metadata.nc” file and re-run all analyses using this data. 

Tracking Analysis Outputs 

Output Files 
Output files are saved in a “Results” folder located in the same parent directory as the 
compressed/exported dataset (Fig 52a & b). Additionally “tracking_metadata.nc” contains the 
complete results in xarray netcdf format for further pythonic analysis. 
 
Dataset: 
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Fig 52a: File structure of tracking analysis output files. 

Results: 

 
Fig 52b: File structure of tracking analysis output files. 

 

●​ Raw Tracking Data - “tracking_data.csv” - CSV file containing 8 key-points per fish, x, y 
coordinate and confidence for each keypoint. Note: This file is likely too large to be opened in 
Excel or other spreadsheet softwares due to the large number of columns in the data array. 
This file can be opened and manipulated using Python, please contact us for example scripts 
to open this file and to learn more. 

●​ Plotted Tracks - “plotted_tracks.png” - Visualization of movement over time from blue 
(earliest, cold) to red (most recent, hot). If “plotted tracks indicate speed” is selected during 
analysis, the color gradient represents is from blue (slow) to red (fast) and green is any speed 
over 50 mm/second. 

●​ Distance Traveled Data - “distance_traveled_metrics.csv” - Distance traveled and speed 
calculated for each frame. 

●​ Aggregate Metrics - “distance_traveled_key_metrics.csv” - Summarized peak speed, total 
distance traveled, and percent of frames found to be not confidently tracked for each well. 

●​ Video Composite - “composite_tracked_video.mp4” - mp4 video containing key-point and 
skeleton labeled fish for all wells of a well plate. 

●​ Skeleton Data - “skeleton_data.csv” - The length, orientation, and tracking confidence of each 
of the eight segments defined by two tracked keypoints for each well. Angles in this output are 
defined with reference to the image coordinate frame and have rotations with 
counter-clockwise orientation. 

●​ Tail Angles - “tail_angles.csv” - For each well, four angles, and tracking confidence for each of 
these angles, are given each describing the angle formed by the “center-to-snout” segment 
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and the center to each of the four tail keypoint segments. More information on this analysis 
can be found below in the “Tail Bend Analysis” section. 

●​ Fish Lengths - “fish_lengths.csv” - Fish length, head length, and tail length are given on a per 
well basis. More information on this analysis can be found below in the “Fish Length” section. 

●​ Eye Analysis - “eye_analysis.csv” - Eye position, distance between eyes,  eye area, fish 
orientation , and eye angle are given on a per well basis. More information can be found below 
in the “Eye Analysis” section. 

 
The CSV header includes MCAM system information and may or may not be useful to the user. Users 
can specify whether to include a header by selecting the corresponding checkbox in the Zebrafish 
Analysis panel. 

Data Sizes 
In the tables below, “Raw Outputs” refers to the sum of all individual well files generated by the 
tracking process, “Minimal Outputs” refers to the sum of individual well mp4 files with all other 
individual well files removed and “Results” refers to the sum of all final files located in the results 
folder. 
To use this table in estimating how much disk space you need for your experiment, you should assume 
that you need the sum of the “Raw Outputs” and “Results” combined for initial processing. Once this 
process is complete, individual well files can be removed (except for individual mp4’s that you will 
want to save in case you decide to re-track your data) to reduce the data footprint. The current GUI 
default will remove extra files automatically. 
 

 
96 Well Plate 

Duration FPS 
Raw Outputs 

(GB) 
Minimal Outputs 

(GB) 
Results 

(GB) 

30 
30 0.3 0.12 0.1 

160 1.33 0.71 0.5 

60 
30 0.54 0.26 0.19 

160 2.6 1.43 0.1 

300 
30 2.44 1.34 0.93 

160 12.78 7.2 4.91 
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24 Well Plate 

Duration FPS 
Raw Outputs 

(GB) 
Minimal Outputs 

(GB) 
Results 

(GB) 

30 
30 0.09 0.05 0.03 

160 0.57 0.29 0.14 

60 
30 0.2 0.1 0.05 

160 1.15 0.6 0.27 

300 
30 1.08 0.55 0.25 

160 5.8 2.98 1.34 
 

Example Tracking Workflow 
An example workflow has been prepared that you can use to understand this process. It can be run 
either from a python script or from the MCAM GUI. If you would like to run it, please download the 
following files: 

●​ 96-well plate .nc file - 120 fps, 10 second duration, IR illumination 
●​ Well keypoint file 

From the MCAM GUI 
1.​ Open the .nc file you have downloaded by double clicking on the file in the MCAM Viewer 

software . 
2.​ Compress the file following the directions above in the section titled “Video Compression”. 
3.​ Load the compressed dataset and use the directions above in the section titled “MCAM 

Zebrafish Analysis” to track the compressed dataset. 
4.​ An output folder will be created in the same location as the compressed dataset. 

From a Python Script 
The example script to run the workflow is titled “Zebrafish Tracking Workflow” and can be found here: 
https://docs.ramonaoptics.com/tracking.hl 
 
We recommend that the “dataset.mp4” and all metadata files should be retained as tracking can be 
reproduced from these files alone in the future if re-tracking is necessary. 
 
To view the accuracy of zebrafish tracking, we recommend the “plotted_tracks.png” and 
“composite_tracked_video.mp4” for visualization. 
 
The result is located HERE for download and viewing. 
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Visualizations 

Plotted Tracks 
Plotted tracks display the path of each fish over the duration of the video analyzed. Color gradients can 
display time from blue (earliest, cold) to red (most recent, hot). If “plotted tracks indicate speed” is 
selected during analysis, the color gradient represents is from blue (slow) to red (faster, 50 mm/sec) 
and green is any speed over 50 mm/second (Fig 53). 
 

 
Fig 53: Example of plotted tracks result.  
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Composite Video 
The composite video displays each well in the array with the skeleton overlaid on each fish in green 
(Fig 54). 
 

 
Fig 54: Example of composite video..  

Assays 

Thigmotaxis 
According to one publication (Schnorr S., et. al, 2011), the authors validate a Thigmotaxis assay using a 
24 well plate (16.2 mm diameter) with both light/dark conditions and stimulant/depressant chemical 
experimental conditions. The authors comments (Materials and Methods Section 2.3, pg. 368) that well 
plate selection is determined by assuring the “swimming arena must be sufficiently large to allow 
distinction between inner and outer zones” and to do this both inner and outer zones must be “at least 
equivalent or larger than the body length of the larvae (approx 4 mm for larvae aged 5 dpf)”. It is also 
noted that a 6 well or 12 well format could work for this assay however using a 24 well plate the area of 
inner and outer zones are equal “thus ruling out biases in the analysis of zone preference related to 
differences in zone size.” Finally they comment that both 96- and 48-well plate formats are likely too 
small to fit these requirements. 
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Reference: Measuring thigmotaxis in larval zebrafish Schnorr et al. 2011 
10.1016/j.bbr.2011.12.016 
https://www.sciencedirect.com/science/article/abs/pii/S0166432811008758?via%3Dihub 
 
This assay has been formulated with the 24-well plate in mind. A schematic is given below showing the 
concentric zones of each well of a 24-well plate. 4 mm is considered the default outer zone width 
however this can be defined by the user (Fig 55).  An example script for this assay based on MCAM 
tracking data can be found at: 
https://docs.ramonaoptics.com/tracking.hl#zebrafish-thismotaxis-assay 
 

 
Fig 55: 24-well plate schematic. 

 
Assay Output: 
Fraction of frames confident per well. 
Fraction time spent in the outer zone per well. 

Fish Length 
A function for computing fish length is included in the MCAM Zebrafish Analysis package. Five skeleton 
segments are defined using the eight key point tracking model and the lengths of these segments are 
computed using euclidean distance for each frame. The median value of each segment across all 
frames is selected as the computed length for each segment in order to filter out extreme values that 
may exist from one frame of faulty tracking. The five (5) segments of interest here (Fig 56) are the: 
 

●​ snout - to - center 
●​ center - to - between_center_and_mid 
●​ between_center_and_mid - to - mid_tail 
●​ mid_tail - to - between_mid_and_caudal 
●​ between_mid_and_caudal - to - caudal_fin 
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Fig 56: Fish length segments diagrammed on a specimen. 

 
 
The head length is defined as the first of these segments (snout-to-center). 
 
The tail length is defined as the sum of the second through fifth segments spanning from the center 
point to the caudal fin. 
 
Outputs for this computation on a per well basis include: 

●​ Fish Length 
●​ Head Length 
●​ Tail Length 

 
Example output fish_lengths.csv (Fig 57): 

 
Fig 57: Example csv of fish lengths. 

72/142 

 
Ramona Optics - MCAM User Manual 



 

Skeleton Analysis 
 

 
Fig 58: Skeleton analysis overlay example and orientation diagram. 

 
​ The zebrafish “skeleton” refers to the line segments connecting each of the key points of the 
fish. Potentially interesting values include the length of each of these segments and the segment angle 
within the image frame (Fig 58). The skeleton is automatically overlaid on each fish in the 
“composite_video.mp4” results file and can be used to qualitatively validate tracking accuracy visually 
in addition to potential analysis use. 
 

 
Fig 59: Example skeleton data csv. 

 
The “skeleton_data.csv” results file contains segment measurements of each skeleton segment with 
lengths defined in meters and angles (orientation) defined in degrees with counter-clockwise rotation 
from zero (3 PM on a clock) such as the unit circle (Fig 59). 
 
Important Notes: 
 

As of August 22, 2023 and owl software version 0.18.316, skeleton segment angles are defined 
with counter-clockwise rotation from zero similar to the unit circle. Datasets acquired with previous 
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owl versions have angles defined with clockwise rotation. Owl software version is reported in the 
header of all output files by default.  
 

There is a 90 degree rotation between the acquisition and display of images on most Kestrel 
systems. All tracking metrics are computed with the acquisition coordinate frame and thus there is 
likely a 90 degree difference between zebrafish images and angles reported in results files. Please see 
“Imaging Orientation” for more information. 

 
If you have any further questions regarding these points, please contact us at 

help@ramonaoptics.com. 

 

Tail Bend Analysis 
Tail bend angles to each of the four tail key points are calculated and reported for each well along with 
a tracking confidence. Tail angles are defined as the deflection angle from the fish body axis pointing 
towards the tail (Fig 60). The two vectors defining each angle are formed from the snout-to-center 
point vector and the center-to-tail keypoint vector for each of the four key points. Deflections to the 
fish’s left are positive and to the right are negative (Fig 61). 

 
Fig 60: Tail bend analysis orientation diagram. 

 
The output for tail bend analysis is given in the “tail_angle.csv” file. For many experiments plotting just 
the “caudal fin” angle may be sufficient for tail angle visualization such as below (Fig 62). 
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Fig 61: 160 fps acquisition, high frame rate (Bin 4) imaging mode, 2ms exposure.  Blue is the center-to-snout vector, purple is the body axis 

pointing to the opposite direction, and red is the center-to-caudal fin vector. 

 
Fig 62: Example fin angle plot. 
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Fig 63: 30 fps acquisition, high resolution (Bin 1) imaging mode. Diagram of four key points used for tail analysis. 

 
The four key points used for tail analysis are the “caudal_fin”, “mid_tail”, “between_center_and_mid”, 
and “between_mid_and_caudal” which exist in the tracking dataset in that order (Fig 63). Tail 
information can be accessed in python by opening the “tracking_metadata.nc” dataset and accessing 
“tracking_dataset.tail_information”. An example “Tracking Dataset - Data Analysis” noting how to 
access this data for analysis is given HERE. 
 

 
Fig 64: Example csv of tail angles output. 
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Eye Analysis 
Automated eye analysis for zebrafish using MCAM provides detailed morphometric information about 
zebrafish eye structures. The analysis uses key point tracking data and yields the location of each eye 
within the image frame, fish heading, distance between eyes, area of each eye, and the angle of each 
eye with respect to the fish body axis. For the complete analysis it is important to process data 
acquired at high (Bin 1) or medium (Bin 2) resolutions to ensure accurate analysis of elliptical eyes, as 
high frame-rate (Bin 4) data only provides the distance between the eyes. This is because at high 
frame-rate eyes appear more circular than elliptical and thus major and minor axes of the ellipse 
cannot be accurately determined consistently. 

The analysis algorithm consists of several steps: 

1.​ Image Cropping: Using the location of the tracked center key point an area is cropped from 
each raw image around each fish to reduce computation of the next steps and exclude 
unnecessary search space. 

2.​ Image Pre-processing: The cropped images are preprocessed using an adaptive thresholding 
algorithm to enhance contrast and remove noise, facilitating more accurate segmentation of 
eye structures. 

3.​ Eye Segmentation: A contour-detection method is used to delineate the eye boundaries and 
find the centroid of each eye within the cropped image frame. 

4.​ Eye Spacing: This distance between eyes is computed in units of pixels. 
5.​ Fish Heading: The fish heading is computed as the angle of a line with respect to the overall 

image frame drawn perpendicular to a line connecting the two eye centroids the points away 
from the center point of the fish. 

6.​ Eye Feature Extraction: The algorithm calculates the area of each eye in units of pixels, and the 
angle of each eye with respect to the fish heading. 

7.​ Coordinate Mapping: The eye centroid coordinates in the cropped frame are mapped back to 
the coordinate frame of the original image. 

8.​ Distance and area values are converted from units of pixels to units of meters and square 
meters using the calibrated pixel width of the MCAM. 

9.​ Results are output in a CSV file titled “eye_analysis.csv” in the results folder of the dataset 
being processed. 
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Fig 65: Description of head angles and eye angles. 

Left: Heading angle / Orientation within a well. Zero degrees (0°) is at 3PM on a clock, similar to the 
unit circle, with counter-clockwise rotation increasing the heading angle. The heading angle of the fish 
is at sixty degrees (60°). Three hundred and sixty degrees does not exist and the angle range is [0°, 
360°). 

Right: A solid blue line connects the eye centroids of the left and right eyes. The purple arrowed line 
represents the heading angle of the fish. Two blue dotted lines are parallel to the fish heading angle 
pointing in the same direction denoting the direction of the fish’s body axis. Two red arrows display 
one half of the major axis of the eye region ellipses. Deflection of an eye to the left of the body axis is 
positive (+) rotation while rotation to the right of the body axis is negative (-).  

 

Fig 66: Example csv of eye angles output. 

Fig 66 is an example of “eye_analysis.csv” with data on a per well basis. Each row displays one time 
point, given in seconds. Locations and distances are displayed in units of meters with reference to the 
well plate and the reference frame origin at the center of the well. Area is displayed in units of square 
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meters. Angles are measured in degrees. Orientation is measured with zero at 3 PM on a clock similarly 
to the unit circle. There is likely a 90 degree rotation between how images are acquired and displayed 
so this orientation may not immediately be apparent. Please see the section on EXIF rotations for more 
information. Eye angles are measured with respect to the fish heading with a positive sign 
representing a deflection to the left of the body axis and a negative sign representing a deflection to 
the right. 

 

 

Fig 67: Visualization of High Resolution (Bin 1) data acquired from a 96-well plate at 30 frames per second: The blue line drawn represents the 
distance between eye centroids, the purple arrowed line is the fish heading, and the two red lines are the direction of each eye respectively. 

The frame number and time in seconds are displayed for context within the overall experiment. 
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Eye Analysis Imaging Parameters 

Eye analysis has been optimized for specific imaging parameters using brightfield visible spectrum 
illumination: 

●​ Standard resolution (Bin 2) 
●​ Illumination: Visible spectrum transmission 
●​ Exposure: 10 ms 
●​ Brightness: 25% 
●​ Digital gain: 1.0 
●​ Analog gain: 1.0 

If your eye analysis requires other imaging parameters, please contact us at help@ramonaoptics.com 
for assistance. 

Tracking Data Filtering 
 
Tracking data filtering is divided into two steps: Anomaly Detection, which finds errors in raw tracking 
data, and Denoising, which removes pixel jitter between series of frames. Anomaly detection is 
applied prior to denoising.  
 
The “Filter Anomalies” and “Denoise / Smooth” checkboxes under Advanced Settings in the Animal 
tracking panel are enabled by default. To filter and reanalyze previously tracked data, check the 
corresponding box shown in the screenshot below (Fig 68). Note: Reanalyzing data will overwrite the 
previous analysis files (however, raw tracking data is always stored in raw, unfiltered form). 
 

 
Fig 68: Animal tracking  panel data reanalyzing option. 
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Anomaly Detection 
Anomaly detection finds and removes large errors in tracking using criteria to identify situations that 
are not physically possible. Data points found to be erroneous are removed and these regions are filled 
by linear interpolation based on the surrounding regions. Four filters are used in combination: 
boundary filtering, speed thresholding, center-of-mass filtering, and outlier window filtering. 
 
Boundary filtering sets a boundary within each image based on the frame centroid and well radius. 
Coordinates outside of this boundary are replaced with null values and these empty regions are filled 
by linear interpolation after all anomaly detection filters have been applied (Fig 69). 
 

 
Fig 69: Example of boundary filtering of a 96 well plate. (Left) Erroneous tracking occasionally jumps outside of a well. (Center) The 
predefined boundary is visualized on the well in white. (Right) Filtered data removes tracking data that jumps outside of the well. 

 
Speed thresholding defines a maximum speed that is possible for zebrafish and values above this 
threshold are removed. The speed threshold is set at 120 mm/sec above which we believe is not 
possible for zebrafish larvae. Data points resulting in a speed greater than this threshold are replaced 
with null values and these empty regions are filled by linear interpolation after all anomaly detection 
filters have been applied. Following interpolation movement metrics are recomputed. This can result 
in speed values above the threshold value, however when we quantify the number of these values, we 
find ~135x decrease in abnormal speed values. 
 
Center-of-Mass (CoM) filtering computes the average location of key points in each frame and if any 
key point is greater than 0.7 times the length of the fish away from the CoM, the point is removed. In 
the GUI workflow fish length is computed prior to filtering so that the length measurement can be 
used in CoM filtering, and then the fish length is computed again after filtering is complete. (Fig 70) 
Fish length must be computed prior to CoM filtering. Eye keypoints are not considered in this 
computation because if included, the CoM is biased towards the head of the fish. 
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Fig 70: Artistic rendition of Center-of-Mass (CoM) computation displaying zebrafish key points in orange and the computed CoM as the blue 

star. The green circle indicates the region in which key points could reasonably reside. Note: Eye key points are not included in the CoM 
computation. 

 
Outlier window filtering is applied after all other anomaly detection filters and removes data that the 
deletions of previous filtering has indicated to be likely to be erroneous.  Outlier window filtering finds 
regions of good data bounded by null values (null values are only included in a dataset when anomaly 
filtering deletes data) and removes each of these regions if each single region is shorter than four (4) 
frames  
 
It is important to note that raw tracking data is always stored in the “tracking_metadata.nc” file in 
original form to ensure that it is unaltered for future re-analysis. When Filter Anomalies are checked in 
the Animal tracking panel, computations stored in the NC file, such as skeleton, tail, length, and eye 
information, are based on the data post anomaly detection. Anomaly detection must be applied each 
time the dataset is loaded for data manipulation because the data is stored in raw form (the filtered 
dataset is never stored). 

Denoising 
Denoising attempts to remove jitter from keypoints placed on sequential frames of data. At low frame 
rates and short acquisition durations this jitter is less important, however at high frame rates and long 
acquisition times the accumulated distance computed between these pixel movements will greatly 
outweigh the signal of interest. 

 
Ramona’s wavelet denoising algorithm estimates the variance of each keypoint and then applies 
wavelet denoising using the “sym4” wavelet. Examples of raw and smoothed distance traveled data for 
both instantaneous and cumulative distance traveled are given below (Fig 71). 
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Fig 71: Examples plots before and after denoising application. 

 

Filtering has been optimized for the zebrafish center key point and should only be used for key points 
of the head which move at similar frequencies. The tail key points for example move at higher 
frequencies and should not be filtered with this strategy. Smoothing key points that move at higher 
frequencies has the potential to significantly change collected data and introduce artifacts, as can be 
seen in the example below. This example shows smoothed tail key points (Top) compared to raw 
(Bottom) (Fig 72). Notice that smoothing in this case changes the data significantly throughout as well 
as introduces at least one rather extreme artifact highlighted by the red arrow. We therefore choose to 
not smooth tail angle data. This is acceptable because jitter error does not accumulate over time in the 
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movement of these key points. Smoothing of all key points is accessible through our API. Please 
contact us for further assistance as this workflow will be workflow specific. 
 

 
Fig 72: Example of how denoising tail angle data can introduce artifacts. 

 
Denoising is implemented by default and can be disabled by unchecking “Denoise / Smooth” in the 
animal tracking panel. It is important to note that the algorithm is only applied during the 
distance traveled computation so distance traveled and speed are the only output metrics 
affected. All tracking data is stored in raw form both in output CSVs and in the “tracking_metadata.nc” 
file so that we can ensure it is unaltered for future re-analysis and thus denoising must be applied each 
time the dataset is loaded for data manipulation.  

Time Binning 
Tracking data output in CSV format is often massive in scale, making it unusable.  Traditional CSV 
softwares including Microsoft Office Excel and LibreOffice Sheets have limits on the number of rows 
and columns that can be displayed, and high frame rate, long duration recordings will often surpass 
these limits in which case the CSV’s cannot be opened in their entirety.  

 
Tracking data is thus binned by default in one second increments. Unchecking Bin Data Output will 
disable this feature and yield raw outputs. The time bin increment can be changed in the field to the 
right of the Bin Data Output checkbox. All output data is binned by this time increment. Distance 
traveled data is summed within each time period while all other data is averaged. Time bin increments 
are limited to one decimal place so 0.1 second is the smallest bin allowed. If the duration is not evenly 
divisible by the user requested time bin, the last bin will not be full and it will be removed 
automatically from the output data to ensure that all bins are of equal importance. We recommend 
choosing time bins that divide the total duration evenly. 
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It is important to note that the validity of binned data depends on interpretation of each specific 
experiment’s requirements. It is likely that binned tail angle and eye angle data which is averaged over 
one second has less validity than the native resolution and thus we recommend not binning data 
where high time resolution is required such as with these high frequency measurements. 
 
For other questions, please contact us at help@ramonaoptics.com. 

Zebrafish Segmentation 
Image segmentation based workflows have been integrated into the MCAM Viewer software for use 
with zebrafish. The basis of this technique locates a zebrafish within each well and defines a region of 
interest highlighting the fish within the image. Once the fish region is defined, analyses within this 
region can be performed such as cell counting, fluorescence quantification or area measurements. For 
more information on the underlying mechanics of this workflow, please see our publication in PLoS 
One (2023) titled Automated, high-throughput quantification of EGFP-expressing neutrophils in 
zebrafish by machine learning and a highly-parallelized microscope. 
 

 
Fig 73: Zebrafish expressing Lyz:EGFP segmented from the background. The defined region of interest is displayed with a yellow line. 
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This type of analysis can be customized for many use cases that involve analysis within a defined 
region. For example, rather than segmenting the entire fish, it is possible to segment just the eyes or 
yolk sac in order to measure morphological areas. For more information on extended use cases and 
customization, please contact us at help@ramonaoptics.com. 
 

Segmentation GUI Panel 
The segmentation panel within the MCAM Viewer can be opened from the Assays>Zebrafish menu. 

 
Fig 74: MCAM Viewer Panel for Segmentation 

 
Segmentation analysis is initiated by selecting a segmentation model from the “Model Selection” 
menu and then clicking “Segment Instances”. The base segmentation analysis simply determines a 
region of interest for each well. Additional analyses within the region of interest can be added by 
selecting the respective check box in the “Analysis Options” section. 
 
Input datasets to the segmentation workflow can be either a single frame of a well plate or well plate 
subset or a z-stack acquisition which has multiple frames per well with varying levels of focus. If a 
stack dataset is found, automatic focusing is applied before the final segmentation which selects the 
most in-focus frame for each well. A new dataset is output to the results folder containing only the best 
focus frames. 
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Fig 75: Detailed segmentation panel. 

Segmentation Options 

Filter Regions: This option, selected by default, filters all segmented regions and returns only the 
largest region identified. 

Analysis Options 

Compute Region Areas: When selected, an area value is computed for each segmented region. This 
value is reported in square SI units defined in the panel above. Accurate pixel width calibration of the 
MCAM is required as this value is used to compute areas. 
 
Compute Fluorescence Intensity: When selected, a bulk fluorescence value is computed for each 
region following a pixel intensity threshold. The threshold is applied setting any pixel values within the 
region of interest below the pixel intensity threshold (user defined above) to zero while pixel values 
equal to or greater than the threshold value remain unchanged. Only one color channel is considered 
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in this analysis as defined by the selected color channel just above in the segmentation panel. Pixel 
values within the region are summed and reported with arbitrary units (AU). 
 
Count Blobs: When selected, blobs are counted within each region of interest following a pixel 
intensity threshold. A blob is a round-like group of pixels which can be extended to fluorescent cells, 
chromatophores or other such entities. The pixel intensity threshold is applied, setting any pixel values 
within the region of interest below the pixel intensity threshold (user defined above) to zero while pixel 
values equal to or greater than the threshold value remain unchanged. Only one color channel is 
considered in this analysis as defined by the selected color channel just above in the segmentation 
panel. Minimum and maximum blob size thresholds are defined to limit computation when searching 
for blobs. 
 

Export Settings 

Combine CSV Results: When selected, all output metrics are displayed in one CSV file with a column 
for each individual metric and row for each well. This setting is selected by default making it easier to 
visualize multiple endpoint metrics together. If this setting is deselected each metric is displayed in a 
separate CSV file in arrayed format similar to a well plate layout. 
 
Export Masked Images: When selected, an image is exported for each well with the segmented region 
overlaid on top of the image. Overlays are represented by a yellow line defining the outer perimeter of 
the region of interest. 
 
Export Regions: When selected, segmented regions are exported as numpy arrays which can be used 
in further analysis. Each array consists of one channel with the same height and width as the 
segmented region. Most values of the array are zeros, with ones in region locations. This is considered 
an advanced feature. 
 
Export Annotations: When selected, cartesian coordinates for each segmentation mask are exported 
along with individual images. Annotations are exported in vgg16 data format and can be used for 
training and fine-tuning additional segmentation models. This is considered an advanced feature. 
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Analysis Computation Explained 
Explanations of how analysis metrics of interest are calculated. We are constantly striving to improve 
our methodologies and depend on feedback from our collaborators and customers to continue this 
optimization.  
 
Questions and feedback, please contact: help@ramonaoptics.com 

Units 
Unless otherwise specified, exported units implicitly: 
 

●​ Distance or length:​ ​ meters 
●​ Time:​ ​ ​ ​ seconds 
●​ Velocity or speed:​ ​ meters/second 
●​ Orientation/Angle:​ ​ degrees 

Distance Traveled 
1)​ Location values below a confidence threshold are removed and the resulting gaps are (𝑥, 𝑦) 

filled by linear interpolation between the previous and following confident points. By default, 
this threshold is set to 0.1 as of owl version 0.18.100. 

2)​ The percentage of the total frames deemed non-confident are recorded to be provided to the 
user in the file. 

3)​ The positions,  and  are then filtered with a moving average of length 𝑥 𝑦
 𝑙𝑒𝑛𝑔𝑡ℎ =  𝑚𝑎𝑥(⌊ 𝑓𝑟𝑎𝑚𝑒 𝑟𝑎𝑡𝑒

60 ⌋, 1)

 𝑎𝑚𝑝𝑙𝑖𝑡𝑢𝑑𝑒 =  1
𝑙𝑒𝑛𝑔𝑡ℎ

 
a)​ Where ⌊   ⌋ denote the integer flooring operation. 

4)​ The euclidean distance between each key-point in two adjacent frames is calculated with units 
of meters (Fig 76). 
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Fig 76: Diagram of euclidean distance. 

 
5)​ The first frame is assigned a distance traveled of zero because movement cannot be calculated 

for this frame. 
6)​ Total distance traveled is the sum of the distances traveled between each frame. 

Speed 
1)​ The sampling period for each frame of an acquisition is defined to be the inverse of the frame 

rate. 
2)​ Speed is computed to be the distance traveled between two adjacent frames (see above) 

divided by the sampling period. Speed is computed for every frame in a video. 
3)​ Peak speed is  the maximum speed computed over all frames using the above methodology. 
4)​ The first frame is assigned a speed of zero because movement  and thus speed cannot be 

calculated for this frame. 
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Stitching Images Through MCAM Viewer 

 
Fig 77: stitching panel. 

1)​ With your desired single frame dataset loaded into the MCAM Viewer navigate to File>Export 
Image (as stitched). 

2)​ The stitching panel will pop up on the right side of the viewer (Fig 77). 
3)​ Select the output resolution of your stitched image.  
4)​ Once resolution is selected, frame the viewer to the FOV you would like your stitched image to 

cover. You can navigate this viewer the same as in the MCAM Viewer and MCAM . 
5)​ To quickly fit the FOV to the full composite press the following button (Fig 78): 

92/142 

 
Ramona Optics - MCAM User Manual 



 

 
Fig 78: Full composite button. 

 

6)​ Deselecting “Quick Stitch” will improve blending across the seams of the image, but will take a 
much longer time to perform the stitch. 

7)​ If working with a stack (video, z stack, exposure stack, ect.) then selecting “Stitch Stack” will 
allow you to stitch multiple sequential frames between the given “Start Frame” and “End 
Frame”. 

8)​ Once the preview window is set, press the “Stitch” button. This will bring up a File Navigator 
that will allow you to select the filename of the stitched image. 

9)​ A progress bar will appear to monitor the stitching and display the location of the stitched 
image. 
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Estimated File Size and Recording Duration 
for Video Acquisition 
 
We provide the table below to help guide users through the different options available for recording 
video. For maximum data bandwidth, the data captured from the MCAM must be stored in RAM. The 
workstations provided with the MCAM contain between 128 GiB and 1024 GiB of RAM depending on the 
configuration that can be used for video acquisition. For data rates below 2 GiB/s, it is possible to use 
the provided SSDs instead of RAM to store the raw video files. For data rates below approximately 610 
MiB/s, it is possible to compress the video during the recording to extend the recording duration given 
the same file save on the storage media. 
 

Well 
Plate 

 High Resolution​
bin x1 

Standard Resolution​
bin x2 

High Speed​
bin x4 

96 Maximum FPS 1024 × 1024 / well 
@ 30 fps 

512 x 512 / well ​
@ 60 fps 

256 x 256 / well ​
@ 160 fps 

96 GiB RAM 
Recording 

2.8 GiB/s (30 sec) 1.4 GiB/s (65 sec) 0.93 GiB/s (100 sec) 

300 GiB Disk 
Recording 

N/A 200 sec (3 mins, 20 sec) 320 sec (5 min, 20 
sec) 

30 GiB mp4 
Recording 

N/A 30 fps, 400 sec (6 mins, 
40 sec) 

80 fps (10 mins, 40 
sec) 

24 Maximum FPS 2048 × 2048 / well 
@ 30 fps 

1024 x 1024 / well ​
@ 60 fps 

512 x 512 / well ​
@ 160 fps 

96 GiB RAM 
Recording 

2.8 GiB/s (30 sec) 1.4 GiB/s (65 sec) 0.93 GiB/s (100 sec) 

300 GiB Disk 
Recording 

N/A 200 sec (3 mins, 20 sec) 320 sec (5 min, 20 
sec) 

30 GiB MP4 
Recording 

N/A 30 fps, 400 sec (6 mins, 
40 sec) 

80 fps (10 mins, 40 
sec) 

48† Maximum FPS 1408 × 1408 / well 
@ 20 fps 

704 x 704 / well ​
@ 30 fps 

352 x 352 / well ​
@ 30 fps 

96 GiB RAM 
Recording 

4.2 GiB/s (20 sec) 1.58 GiB/s (60 sec) 0.39 GiB/s (240 sec) 
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300 GiB Disk 
Recording 

N/A 440 sec (7 min, 20 sec) 30 min 

30 GiB mp4 
Recording 

N/A N/A 30 min 

8 Maximum FPS 2304 × 2304 / well 
@ 30 fps 

1152 × 1152 / well  ​
@ 60 fps 

576 × 576 / well  ​
@ 120 fps 

96 GiB RAM 
Recording 

1.18 GiB/s (80 sec) 1.58 GiB/s (60 sec) 0.39 GiB/s (240 sec) 

300 GiB Disk 
Recording 

240 sec (4 min) 500 sec (8 mins, 20 sec) 1000 sec (16 mins, 40 
sec) 

30 GiB mp4 
Recording 

N/A 500 sec (8 mins, 20 sec) 1000 sec (16 mins, 40 
sec) 

 

†RAM recordings for 48 well plates are required to capture the full 3072 x 3072 region of interest of each 
of the 24 micro cameras in the Kestrel MCAM. As such, RAM recordings are slightly less efficient than 
their counterparts that use the well plate alignment to reduce the data size when saving raw data to an 
.nc file or compressed data to an mp4. 

System Calibration 
All system calibrations are configured during initial setup. For further information on system 
calibration please contact us at help@ramonaoptics.com. 

Programming Interface and API 
Higher level functionality for the MCAM is provided through a Python® 3 module. This module is 
installable through Ramona Optics’ Anaconda channel. An authentication token will be provided to 
you at the time of sale .  
 
Once installed, the owl module can be imported using 
 

import owl 
 
Python API details are provided in the API manual: https://docs.ramonaoptics.com/ 
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Accessories 

Stage Inserts 
 
A Multiwell Microplate Insert from ASI Imaging is included with the MCAM. Other inserts can be 
purchased from ASI Imaging at www.asiimaging.com and utilized according to your workflow. The 
MCAM stage accepts inserts with dimensions 160 x 110 mm. 

Multiwell Microplate Insert - I-3020  
 

 
Fig 79: Multiwell Microplate Insert CAD render. 

 
Insert Exterior Dimensions: 160 x 110 mm 
Insert Interior Dimensions: 128 x 86.1 mm 
Accepted Microplate Dimensions: 127.5 x 85 mm 
 

Other Recommended Inserts 
 

●​ 98mm Petri Dish Insert: I-3098 
●​ 88mm Petri Dish Insert: I-3088 
●​ 85mm Petri Dish Insert: I-3085  
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Vireo 

Graphical User Interface (GUI) 

Opening and Closing the MCAM 
 
After installing the acquisition software, and turning on the MCAM, the Graphical User Interface (GUI) 
can be started by clicking on the Ramona Optics  application launcher on the sidebar. By default,  the 
MCAM will attempt to connect to each of three components:  

●​ The reflection illumination board,  
●​ The transmission illumination board, 
●​ The stage motor. 

If any of these components are unavailable, the user can choose to not connect these components by 
deselecting their boxes in “Select Components” under the “Advanced” menu on the toolbar. This will 
automatically disable the ability to change the settings for these components. 
 
The MCAM can be closed using the “Exit” button from the File menu,  or by exiting the GUI with the “X” 
button in the upper right corner. Either method will stop all ongoing operations and safely close the 
MCAM. 
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Fig 5: GUI start screen, with the “File” menu open and “Exit” highlighted. 

GUI Navigation 
 
The user can zoom and pan in the GUI to view any section of the streamed or acquired images. To 
zoom, either scroll up and down on the mouse wheel, or move the mouse while holding the right click 
mouse button. To pan, move the mouse in any direction while holding down the left click button. 
 
At the top left of the window (Fig 6, #1) the current file location is displayed. This is the location where 
all files will be saved.  
 

 
Fig 6:  GUI layout with 1) Selected file location, 2) Image Acquisition Mode Buttons, 3) Image Acquisition Settings Panel, 4) Picture-in-picture 

and 5) Key Image Specifications highlighted. 
 
At the top left of the window (Fig 6, #2), the Image Acquisition Mode Buttons allow the user to 
livestream the microscope or view at one single moment. The following are the functionalities 
provided:  

-​ Stream All Sensors: livestream everything under the microscope at the wells selected by the 
users. 

-​ Refresh Image: allows users to see everything under the microscope at one single moment at 
the wells selected by the users.. 

 
The image acquisition settings panel is on the left side of the viewing window (Fig 6, #3). 
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While panning, the picture-in-picture (Fig 6, #4) in the right-hand corner of the screen shows the 
portion of the wells currently in  display.  
 

 
Fig 8: Key Image Specifications 

  
Some key image parameters are displayed at the bottom of the viewing window (Fig 6, #5 and Fig 8) 
including a scale bar providing an approximate scale. Temperature indicated is the ambient 
temperature if the unit is without environmental control. Temperature indicated is the temperature in 
the environmental control chamber if the unit comes with environmental control. 
 

MCAM Settings 
Most of the MCAM Settings can be adjusted using the Settings Panel on the left side of the GUI. 
 
The panel can be hidden to make more room on the screen by clicking on the white line border 
between the settings panel and the image, and sliding to the left. The GUI allows the user to set the 
system parameters within a range of values acceptable for most common experimental setups. More 
customized settings can be set in the Advanced submenu. 
 
Most settings values can be adjusted either by using the sliders or by directly typing a value into the 
text box. When using the text box, the accepted values will still be limited to the maximum and 
minimum values shown on the respective slider. In addition, the setting displayed in the text box may 
adjust to a value slightly higher or lower than the value entered. This is because for  certain  settings  
(particularly  digital  and  analog  gain),  the  MCAM  can  only  accept  distinct values. The GUI will 
automatically round the entered setting to the nearest acceptable value, and send that parameter to 
the MCAM system. 

Loading/Saving Settings 
On first use, the GUI will load a set of predetermined default settings which were chosen to produce 
generally high quality images. Afterwards, the GUI will automatically load the settings from its last use. 
Because each unique imaging environment and sample may have different optimized settings, the 
settings for individual experiments can be saved and loaded using the “File” menu in the toolbar, 
selecting “Save Settings” within it. The default settings can also be re-loaded using the “Restore 
Default Settings” button in the same menu. 

Image Acquisition Settings 
The sensor exposure, gains, and LED parameters can all be set from the setting panel on the left side of 
the GUI, as well as contrast levels of the displayed image. These settings are further explained below. 
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Exposure: This setting controls the amount of time that the camera sensor acquires light for each 
frame. A longer exposure will yield a brighter image with more motion artifacts while shortening the 
exposure will darken the image with fewer motion artifacts. Additionally this setting will affect the 
framerate when using streaming acquisition modes with longer exposures decreasing potential 
framerate. In order to maximize framerate, consider keeping the exposure as low as possible and 
balance lighting with the brightness setting. 
 

 

 
Fig 9: Camera sensor settings. 

 
Digital and Analog Gain: Gain settings will magnify the signal produced by the image sensors. Analog 
gain increases the sensitivity of the sensors using hardware while digital gain increases the signal 
using software to multiply the signal once it has been converted to a digital signal. Increasing gain 
values will increase image intensity but will also increase noise proportionally. Keeping gain values as 
low as possible will reduce inherent noise (Fig 9). 
 
Brightness: Located under “Illumination Settings”, this will control the overall brightness of the LEDs 
used to illuminate the sample (Fig 10). 

 
Fig 10: GUI LED board settings 
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Stage Position: The location of the Z-stage can be changed using either the up and down arrows or by 
manually entering a location (given in millimeters from the highest point where the stage can be 
positioned) (Fig 11) on the Z scale within the “Stage Position Panel”. Step size controls the increment 
by which the arrows will adjust the height. Adjusting the Z-stage location will move the stage and 
sample in and out of focus.  
 

 
Fig 11: Z-stage settings. 

 
Gamma: Adjusting this value will control the encoded image’s sensitivity to bright and dark tones and 
is an effective method of controlling the overall image contrast as perceived by humans (Fig 12). 
Reducing Gamma will decrease shadows and darker tones yielding a brighter image. Right-clicking on 
the Gamma bar allows users access to predetermined Gamma levels (Fig 13). 
 

 
Fig 12: GUI contrast settings. 

 

 
Fig 13: GUI contrast settings. 

 

101/142 

 
Ramona Optics - MCAM User Manual 



 

Save and Export Images 
 
MCAM data can be exported or saved from the GUI in several ways. First, high resolution images can be 
exported using the “Save Image as Tif” button (Fig 14). “Select File Location” will open the directory in 
which the most recently saved images were placed. 
 

 
Fig 14: Save settings. 

 
Saved images are given a filename according to the following rules: 

1.​ The user defines the prefix of this filename by entering in the “Name” field (Fig 14).  
2.​ The suffix of this filename is generated as a timestamp with the following format​

YYYYMMDD_HHMMSS_mmm where: 
○​ YYYY is the year when the image is saved, e.g. 2020. 
○​ MM is the month when the image is saved, e.g. 08. 
○​ DD is the day when the image is saved, e.g. 06. 
○​ HH is the hour (in 24 hour format) when the image is saved, e.g. 15. 
○​ MM contains the minute when the image is saved, e.g. 43. 
○​ SS contains the seconds when the image is saved, e.g. 52. 
○​ mmm contains the milliseconds when the image is saved, e.g. 549. 
○​ The final timestamp will appear as: 20200806_154352_549 

Notes can be entered in the “Additional Information” field which are saved with the image file and 
displayed in the MCAM Viewer with the image. 
 
Low resolution screenshots of the currently displayed images can be saved using “Capture 
Screenshot” in the “File” menu of the toolbar. This screenshot will include the main canvas, as well as 
the picture-in-picture and the main settings (see Fig 15). 
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Fig 15: Screenshot of GUI Images 

 
Note: If a filename is entered in the “Name” field and the workspace is changed, the filename will be 
deleted and the user will need to enter a new filename. 
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Loading your data with other software 
Often it might be necessary to load the raw data in another programming language for custom 
analysis. In the MCAM Viewer, Ramona Optics applies many image corrections which are not 
automatically applied when loading data using the manual data loading functionalities described 
below. 

Python® 
For our supported platforms, we recommend you utilize the “mcam_data.load” and 
“mcam_data.save” functions to read in the MCAM’s data, along with the available metadata into an 
Xarray Dataarray. However, should you need to export the data as individual camera images, we 
provide the functions “mcam_data.export”. 

ImageJ 
ImageJ accepts both “.jpg” and “.tiff” file types (as well as others) so we recommend exporting images 
from the GUI into one of these formats for use with this software. ImageJ documentation is available 
at: https://imagej.nih.gov/ij/docs/guide/user-guide.pdf  

Matlab® 
Ramona Optics MCAM data is stored in a netcdf4 compatible data format. Data and metadata can be 
read using HDF5 functions in Matlab®. Please follow Matlab’s® documentation to learn more about how 
to read the data. 
https://www.mathworks.com/help/matlab/ref/h5read.hl 

R 
The CRAN Package ncdf4 can aid in loading the raw data in R. 
 

library('ncdf4')​
nc <- nc_open('mcam_gigapixel_microscopy_image_20201103_134639_857.nc')​
raw_data <- ncvar_get(nc, 'mcam_data',​
                  ​ start=c(1, 1, 1, 1), count=c(-1, -1, 1, 1)) 
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Loading Image Files and EXIF Orientation 
 
EXIF (Exchangeable Image File Format) orientation is a type of image rotation that is encoded in the 
metadata of digital images. EXIF is a standard format used by many digital cameras and other imaging 
devices as well as the MCAM. EXIF orientation specifically refers to the rotation of an image that has 
been taken with a camera held in a different orientation than the default. For example, if you hold your 
camera sideways to take a portrait photo, the resulting image will appear rotated 90 degrees when 
viewed on a computer screen. EXIF rotations are important because they ensure that your photos 
appear in the correct orientation when viewed on different devices. Without EXIF rotations, portrait 
photos would always appear sideways on computer screens, which can be confusing and frustrating 
for viewers. By using EXIF rotations, the image is automatically corrected so that it appears as it was 
intended to be viewed. The various EXIF configurations and their respective integer flags are shown 
below (Fig 80). 
 

 
Fig 80: EXIF orientation diagram. 

The MCAM Kestrel currently uses an EXIF 8 orientation when it is configured in the upright imaging 
configuration. This orientation can change depending on the user case in the Advanced Settings menu. 
This may be important to keep in mind during analysis because the orientation can make it seem like 
coordinates are rotated, or inverted. For example, for EXIF 8, images are displayed with a rotation 90 
degrees counterclockwise from how they are acquired so that they are oriented as expected to the 
user. Quantities that refer to the coordinate system of the image data, such as the tracking data 
outputs, specifically angles and coordinates, remain in the coordinate frame of raw data. Therefore 
there is likely a 90 degree rotation between displayed images and videos and the resulting tracking 
data. The MCAM software will take this into account when generating final outputs and ensure that all 
analysis remains consistent. 
 

105/142 

 
Ramona Optics - MCAM User Manual 



 

If you are attempting to load the MCAM data as part of an external pipeline, be sure to read the 
exif_orientation tag in the metadata of the dataset (stored in the associated metadata.nc or 
metadata.json file) to orient the images correctly for display. 

TIFF Files 
 
Due to the large size of the “.tiff” images, we recommend viewing them in either Adobe Photoshop or 
GNU Image Manipulation Program (GIMP). GIMP can be found here: https://www.gimp.org/downloads/ 
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Appendices 

Appendix A: Maximum Recording Time 
 
To ensure maximum transfer rate between the MCAM and the workstation, we included a workstation 
with 128 GB of RAM. Each video recording session is first stored to RAM, and then transferred to the 
included solid state drive (SSD) for permanent storage. The information below represents the longest 
video recording permitted before a pause must be taken in order to transfer the data from RAM to 
permanent storage on the SSD. 
 
The table below is constructed assuming that 100 GB of the 128 GB of RAM is used for video recording. 

Kestrel2850 -- Well plate Imaging 

  
 
 
Megapixels 
per snapshot 

Framerate (frames per second (fps))​
Total frames (count)​
Video Recording (minutes (min) seconds (sec)) 

Ultra resolution High resolution Standard 
resolution 

Microcamera 
configuration 
(Field of View) 

Ultra 
(High) 
[Standard] 
resolution 

Microcamera 
pixels: 
(2048, 2048) 

Microcamera 
pixels: (1024, 
1024) 

Microcamera 
pixels: (512, 512) 

1 × 1 
(18 x 18  mm) 

4.2 
(1.05) 
[0.25] 

45 fps​
25k frames​
9 minutes 15 
seconds 

90 fps 
100k frames 
18 min, 30 sec 

180  fps​
400k frames 
37 min 

2 × 2 
(36 x 36 mm) 

16.77 
(4.2) 
[1.05] 

45 fps​
6.25k frames 
2 min, 20 sec 

90 fps 
25k frames 
4 min, 20 sec 

180 fps 
100k frames 
9 min, 15 sec 

3 × 3 
(54 x 54  mm) 

37.7 
(9.4) 
[2.35] 

45 fps 
2.8k frames 
1 min, 3 sec 

90 fps 
11.2k frames 
2 min 

180 fps 
45k frames 
4 min, 10 sec 

6 × 4  
(108  × 72  mm) 

100 
(25)​
[6.3] 

45 fps 
1050  frames 
23 sec 

90 fps 
4.2k frames 
45 sec 

180  fps 
17k frames 
1 min, 32 sec 
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Kestrel2850 -- Free-swim Imaging 

  
 
 
Megapixels 
per snapshot 

Framerate (frames per second (fps))​
Total frames (count)​
Video Recording (minutes (min) seconds (sec)) 

Ultra resolution High resolution Standard 
resolution 

Microcamera 
configuration 
(Field of View) 

Ultra 
(High) 
[Standard] 
resolution 

Microcamera 
pixels: 
(2560, 2560) 

Microcamera 
pixels: (1280, 
1280) 

Microcamera 
pixels: (640, 640) 

1 × 1 
(18 x 18  mm) 

4.2 
(1.05) 
[0.25] 

30 fps​
16k frames​
8 minutes 50 
seconds 

75 fps 
64k frames 
14 min, 10 sec 

140  fps​
260k frames 
30 min 

2 × 2 
(36 x 36 mm) 

16.77 
(4.2) 
[1.05] 

30 fps​
4k frames 
2 min, 12 sec 

75 fps 
16k frames 
3 min, 35 sec 

140 fps 
65k frames 
7 min, 40 sec 

3 × 3 
(54 x 54  mm) 

37.7 
(9.4) 
[2.35] 

30 fps 
1.8k  frames 
1 min 

75 fps 
7.2k frames 
1 min, 36 sec 

140 fps 
28k frames 
3 min, 20 sec 

6 × 4  
(108  × 72  mm) 

100 
(25)​
[6.3] 

30 fps 
660  frames 
20 sec 

75 fps 
2.6k frames 
35 sec 

140  fps 
10.5k frames 
1 min, 15 sec 
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Appendix B: Dataset size for extended recordings 
 
When operating in high speed mode (High Frame Rate, bin x4), extended recordings are possible and 
limited by the SSD size. Figure A2-1 can help estimate the size of the generated dataset generated in 
these operating modes. The Figure below can help users estimate the size of a recording on an SSD 
based on the chosen frame rate. 

 
Fig 81: Plot of Approximate Data Set Size proportional to Recording Time. 

 
 
​  
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Appendix C: System Disassembly by End User 

High Speed Data Cable Removal 
The installation technician will assist with connecting the MCAM  to the MCAM workstation however 
the user may need to disconnect and reconnect the instrument for instance to move the workstation 
and MCAM . Instructions for successful connection are given below. 
 

1)​ Power down and then disconnect power cords from both the MCAM workstation and MCAM. 
2)​ By pulling perpendicularly to the MCAM using the green flaps, disconnect the SFF-8644 cables 

(see Fig 82 for reference) from both the MCAM workstation and MCAM. 
 

 

 
Fig 82: Dolphin cables with green flaps for removal. 

110/142 

 
Ramona Optics - MCAM User Manual 



 

PCIe Ribbon Cable Installation - MCAM Kestrel (2022 Revision) 
The installation technician will assist with connecting the MCAM  to the MCAM workstation using the 
PCIe Ribbon cable however the user may need to disconnect and reconnect the instrument for 
instance to move the workstation and MCAM . Instructions for successful connection are given below. 
 

1)​ Power down and then disconnect power cords from both the MCAM workstation and MCAM .` 

 
Figure 83:PCIe Ribbon Cable Workstation end with locking flap highlighted on the left side. 

 

2)​ Align the male end of the PCIe Ribbon Cable with the port on the motherboard of the MCAM 
workstation with the locking flap on the left side (Figure 84). The PCIe port is located just 
below the graphics card and above and to the right of the wifi card in the workstation. Gently 
press the PCIe connector into the socket making sure the connector lock engages the locking 
flap on the left side. 

 

 
Figure 84: Connecting the PCIe Ribbon Cable to the MCAM workstation with connector lock highlighted. 
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Reflection Illumination Board Installation 
This section is only applicable to MCAMs with 54 multi-cameras sold under the brand name Falcon, 
and not Kestrel. 
 
The reflection illumination board can be mounted to the upper surface of the MCAM to enable 
reflection lighting. Follow these directions to install this board. 
 

 
Figure 85: Mounted reflection illumination board on the upper surface of the MCAM  with 1) Power source cable, 2) Trigger Out and In, and 3) 

Microcontroller Cable and Teensy Microcontroller highlighted. 
 

1)​ Power off and disconnect power from theMCAM . 
2)​ Align the reflection illumination board with the upper surface of the MCAM . 
3)​ Locate the reflection illumination board connection wires at the rear of the upper mounting 

surface. 
4)​ Connect the power source cable (Figure 85, #1) to the corresponding port on the illumination 

board. 
5)​ Connect the Trigger Out and Trigger In cables to their respective port. Note that each cable is 

labeled In or Out and their ports are labeled on the illumination board (Figure 85, #2). 
6)​ Connect the microcontroller cable to the Teensy Microcontroller (Figure 85, #3). 
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7)​ Mount the reflection illumination board to the MCAM by lining up the back edge of the board 
into the inset and gently pressing the board into the inset. The board will be held in place by 
magnets and should sit flush with the inset guide (Figure 86). 

 

 
Figure 86: Upper surface of the MCAM  showing the system optics and reflection board inset. 
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Appendix D: Trigger connectivity 

Output Trigger 
●​ Signal voltage level: 5 V 
●​ Trigger pulse width: 1 ms (nominal) 

 
The MCAM will output a pulse on the following events: 

1.​ Start of frame or video acquisition. 
2.​ At the start of image data transmission from the image sensors. 

The width of each pulse takes on a value of: 
 

 𝑝𝑢𝑙𝑠𝑒 𝑤𝑖𝑑𝑡ℎ =  𝑚𝑖𝑛(1 𝑚𝑠,  𝑒𝑥𝑝𝑜𝑠𝑢𝑟𝑒 ×  0. 4)
 

Configuration of Output Trigger Events 
As of software version 0.19.244, the MCAM software provides granular control over when the output 
trigger pulse is generated. These settings are accessible under the Advanced Settings → Output Trigger 
tab once the MCAM is connected. All selected options are saved as part of the assay configuration to 
ensure reproducibility across acquisitions. 

 
Each of the following options may be independently enabled or disabled, allowing for fine-tuned 
synchronization with external instruments: 

1.​ Start of Snapshot: Emits a trigger pulse immediately when a snapshot (single-frame 
acquisition) is initiated by the software. This pulse precedes actual data acquisition and can be 
used to activate external devices in anticipation of exposure. 

2.​ Frame Received Snapshot: Emits a trigger pulse when the first pixel of image data is received 
from the image sensor following a snapshot request. This pulse represents the exact start of 
data transmission, and the time difference between this and the “Start of Snapshot” pulse 
approximates the exposure time. 

3.​ Start of Video: Emits a single pulse at the beginning of any video acquisition sequence. This is 
useful for gating other systems (e.g., stimulus generators, electrophysiology recording) to align 
precisely with the start of video capture. 
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4.​ Frame Received Video: Emits a pulse for every frame received during a video acquisition. This 
allows users to align external systems with the actual imaging rate of the MCAM and is ideal for 
use cases requiring per-frame event locking. 

Output Trigger for usage with Animal Trackings 
The Animal Tracking panel in the MCAM GUI provides an additional interface to generate output 
trigger pulses with precise control during the video acquisition timeline. This mode is particularly 
useful for behavior experiments requiring synchronization between the Kestrel and external actuators 
and is available to Kestrel systems equipped with the external trigger option and software version 
0.19.258 or above. These pulses will be generated in addition to any other triggers enabled in the GUI, 
for example at the start of video acquisition, or the start of data received. It may be desirable to disable 
all other events for the output trigger. 
 
Users can specify one or more pulse times (in seconds) relative to the start of video acquisition, and 
the MCAM system will emit pulses at the desired times, independent of the video capture settings. To 
configure: 
 

1.​ Navigate to the Animal Tracking panel. 
2.​ Select your desired assay settings. 
3.​ Navigate to the stimulus section and select "External" 
4.​ For each desired pulse, add the time corresponding to the rising edge. 

 

 
These pulses will be automatically emitted during acquisition and also recorded in the exported CSV 
data and behavior plots and can be intermixed with other stimuli. 

Known issues 
The output trigger may at times emit more pulses than the number of frames requested when the 
MCAM is used in “software trigger mode” (default). 
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Input trigger 
The use of the external input trigger capabilities are currently quite limited. Please contact Ramona 
Optics to discuss your use case for more information. 
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Appendix E: Sensor Optical Characteristics 

Sensor Core Characteristics - Single Sensor 
 

Parameter Symbol Unit Value 

Pixel Size Ps um 1.1 

Vertical Pixels Vp # 3120 

Horizontal Pixels Hp # 4096 

Analog Gain Ag Max 2x Typical 
7.75 Absolute Maximum 

Digital Gain Dg Max 4x Typical 
7.98x Absolute Maximum 

Chief Ray Angle CRA degree 11 

Frame Rate (Bin 1) Fr1 fps 15 

Frame Rate (Bin 2) Fr2 fps  

Frame Rate (Bin 4) Fr4 fps  

 

High-speed Fruit Fly Configuration 
 

Sensor Characteristics -  Array 

Parameter Symbol Unit Value 

Pixel Size Ps um 1.1 

Vertical Pixels Vp # 2048 

Horizontal Pixels Hp # 2048 

Analog Gain Ag Max 7.75x 

Digital Gain Dg Max 7.98x 

Chief Ray Angle CRA degree 11 
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Frame Rate (max) Fr fps 45 

Data Rate (single sensor max) @ Fr D1 MB/s 188 

Max Data Rate (sensor array max) @ Fr Dm MB/s 6100 

Recording Duration per 100 GB @ Dm Tr sec 17.7 sec 

 

Sensor Characterization Parameters 

 
Sensor ADC Bit depth: 10 bit 
MCAM Data Transmission: 8 bit 
 
The 8 bits returned to the computer are the 8 MSBs of the sensor’s digitized 10​ bit val. 
 
Example:  

Sensor pixel value 301 (Maximum value 1023).  
MCAM transmission value to computer 75 (Maximum value 255). 
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Sensor Spectral Characteristics 

 
RBG (Bayer) CMOS: Nominal quantum efficiency of each color pixel in the sensor array 

 

 
Monochrome CMOS: Nominal quantum efficiency of each pixel in the sensor array 
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Appendix F: Thermal Monitoring 
 
Temperature information is included in the MetaData for all data acquisitions as outlined below. 
 

Operating Mode Reporting Period Temperature A Temperature B 

Image 1 Ambient Image Chamber 

Video 1 per second Ambient Image Chamber 

Timelapse 1 per minute Ambient Image Chamber 

 
 
The MCAM is equipped with (2) two thermistors that are used to report Temperature A and 
Temperature B as defined above. One (1) thermistor is positioned on the exterior of the MCAM system 
while the other is positioned inside the imaging chamber to provide temperature readouts near the 
sample. 
 
Image Chamber temperature and the temperature of the water in a 96-well plate inside the Image 
Chamber over time at different IR settings (given an ambient temperature of 21-24 C) is characterized 
within the tables below.  

Well Plate Water Temperature Table 
 

 time = 0min time = 5 min time = 30 min time = 60 
min 

time = 90 min 

0% IR 27 26 25 24 24 

25% IR 27 27 26 25 25 

50% IR 27 27 25 24 24 

75% IR 27 26 25 25 25 

100% IR 27 26 26 26 26 
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MCAM Kestrel Chamber Temperature Table 
 

 time = 0 min time = 5 min time = 30 min time = 60 
min 

time = 90 min 

0% IR 24.9 25.01 25.09 25.23 25.35 

25% IR 25.46 25.66 25.89 25.93 25.76 

50% IR 23.96 24.23 25.09 25.51 25.62 

75% IR 25 25.4 26.37 26.6 26.48 

100% IR 25.15 25.53 26.76 27.25 27.52 
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Appendix G: Environmental Control 
 
The MCAM  system can integrate with third-party stage-top type environmental systems units when 
active environmental control is required.  
 
When working with samples that require sustained elevated temperatures, or when granular control of 
temperature and/or environmental gas concentrations is needed, we encourage the user to work with 
knowledgeable vendors of environmental control systems. Such systems can be easily integrated with 
the Ramona Optics MCAM in both the Enclosed and Open operating condition as shown below. 

 
Fig 87: Active control of the environment using a stage top incubator. 

 

The anodized aluminum drop-in type stage provided by Ramona Optics accepts most active 
environmental chambers from third-party vendors that are designed to integrate with a 160 mm x 100 
mm opening. Ramona Optics has verified adequate fit and cable routing for the stage-top type 
environmental chambers provided by Tokai Hit as shown below. 
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Fig 88: Close up view of the elements in the active control module. 

 

Note to User: ensure the stage-top environmental control unit engages the integrated spring clips in 
the Ramona Optics drop-in type stage. Engaging the clips ensures level seating on the stage and 
snug-fit during operation. 
 
For additional information on pricing and availability of systems from Tokai Hit, please contact: 

Tokai Hit 
306-1, Gendoji-cho, Fujinomiya-shi, 
Shizuoka-ken, Japan 418-0074 
Phone: +81 544 24 6699 FAX: +81 544 24 6641 
Email: solutions@tokaihit.com 
Reference: Ramona Optics, MCAM - drop-in type stage integration 
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Appendix H: Frame rate control and limitations 
 
We encourage users to benchmark the frame rate of their particular acquisition based on their final 
imaging parameters. The number of cameras enabled, exposure time, and region of interest within the 
sensor will all affect the maximum frame rate. 
 
We attempt to list a few different factors that limit the frame rate of the system.  

1.​ Each sensor is limited to a bandwidth of 195 Megapixels per second. This limitation is 
summarized in the figure below for square images and for images with a height to width ratio 
of 1:2. 

2.​ The total bandwidth from the frame grabber to the computer is limited to approximately 6 
GB/s but depends on the exact hardware configuration of the connected computer. 

 

 
The maximum frame rate when the image settings are set to square images and to a height to width 
ratio of 1:2. The x-axis corresponds to the unbinned image width. Note that not all image sensor 
shapes are allowed in all bin modes.  
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Appendix I: Pixel Unit Conversion between GUI and 
Python 
 
The MCAM reports the acquired region of interest within each sensor in the dataset’s start_pixel and 
end_pixel properties. The start_pixel is reflected in the dataset’s x and y coordinates. 
 
The MCAM method select_pixels assumes the coordinates are in the reference frame of the sensor.  
 
Unfortunately, when exporting the images in a standard image format such as a biap, an offset exists 
between the pixel location reported by the image in an external image editor, and the pixel 
coordinates reported by sensors. This offset is reflected in the metadata.json, but may be confusing to 
the user. 
 
To assist with these workflows, Ramona Optics has enabled a special acquisition mode for the full 
image from the sensor. This acquisition mode must be enabled in the GUI (Version 0.6.14 and above) 
before the MCAM is open. To do so, follow the instructions below: 

1.​ Open the MCAM GUI. 
2.​ Open the “Additional Settings” under the “Advanced” dropdown (Fig 89). 
3.​ Select the acquisition mode that is labeled 3136 x 4224 pixels 

 
Fig 89: Advanced settings panel. 
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4.​ Apply the settings. 
5.​ Open the MCAM. 

 
With these settings, the MCAM will be acquiring all pixels from the imaging sensor starting at the (0, 0) 
coordinate. 
 
This mode does not support high frame rate mode. 
 
Acquiring an image and exporting it will ensure that the coordinates of the exported BMPs are the 
same as those of the imaging sensor. 
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Appendix J: Optical Specs of Objective Lenses: high-speed 
Fruit Fly 

Objective Characteristics -  Array 

Parameter Symbol Unit Value 

Numerical Aperture NA - ~0.02 

Working Distance Wd mm 260-270 

Depth of Field DOF um ~2000 

Objective Pitch p mm 13.5 

Objective Field-of-View FOV mm x 
mm 

15 x 15 
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Appendix K: MCAM Configuration 
 
The MCAM can be configured with different illumination modes and stages for optimal image 
acquisition and analysis. To ensure smooth operation of the MCAM after it is started, we enforce that 
all subcomponents are connected at startup. 
 
The current options for subcomponents include: 

●​ The Reflection illumination module. 
●​ The Transmission Illumination module. 
●​ The Fluorescence Illumination module. 
●​ A stage that moves along the z direction (moves along the optical axis) 
●​ A stage that moves along the x direction (In the plane of the sample)optional 
●​ A stage that moves along the y direction (In the plane of the sample)optional 
●​ A stage that moves along the x axis, but only for the sample. 
●​ A Temperature monitoring module. 
●​ A Plate Tapper module. 

 
The page also allows for configuration of the orientation of the microscope. 

●​ Exif Orientation 8 should be used for:  
○​ Upright Microscope 
○​ A1 in the top left corner 

●​ Exif Orientation 6 should be used for:  
○​ Upright microscope 
○​ A1 in the bottom right corner 

●​ Exif Orientation 7 should be used for:  
○​ Inverted Microscope  
○​ Well A1 in the top left corner 

●​ Exif Orientation 5 should be used for: 
○​ Inverted Microscope 
○​ Well A1 in the bottom right corner 
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Appendix L: Transmission Illumination Module  

 ​  
Fig 90: Transmission Illumination Module 

33 rows 
45 columns 
Total =  33 x 45 = 1485 
IR and RGB checkerboard pattern 
RGB = 743 Total LEDs emitting at  630 nm (R), 525 nm (G), 470 nm (B) 
IR-A: 742 Total LEDs emitting at 850 nm 
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Note: The above lux output per brightness assumes that only transmission RGB lighting is activated. 
Using another light source at the same time may reduce the power output available to the 
transmission lighting board and thus decrease the expected output lux. 
 
WARNING: IR illumination causes a reduction in pixel resolution by about 5%. 
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Appendix M: Fluorescence Illumination Spectra  
 
The MCAM System may be equipped with either a single channel fluorescence or multi-channel 
fluorescence controller. The following plots show the expected spectra of the LEDs emission before 
any excitation filter. 

UV LED - 385 nm Excitation 
Luxeon L1F3-U380200008000. For more information about the LEDs used please refer to their specific 
datasheet found online https://lumileds.com/products/uv-leds/luxeon-uv-u-line/.  
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Royal Blue - 440 nm Excitation 

 

Amber - 590 nm Excitation 
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Appendix N: Imaging Orientation 
 
The MCAM GUI orients the images acquired by the MCAM in a way that resembles how the user inserts 
the sample in the sample holder. This orientation should be set at delivery time, but is configurable by 
the end user in the Advanced Menu. To access this menu, from the  GUI, navigate to Advanced → 
Additional Settings → Subcomponents. To modify the EXIF unselect the “Default Subcomponents” 
option which will open a new panel where this value can be accessed and changed. The orientation 
can be set to one of 8 orientations. We suggest: 

1.​ Kestrel,  upright: EXIF 8 
2.​ Kestrel,  inverted: EXIF 7 

 
The advanced menu window allows one to change the display orientation of the MCAM. The 
orientation can be changed by selecting the desired number for the Exif Orientation 
 
With the correct settings, when a standard well plate is placed under the MCAM with the A1 well in the 
top left corner, the well should appear in the same orientation in the GUI. 
 
No matter the chosen orientation, the datasets remain in an order that is native to the underlying 
hardware. This corresponds to the image that would appear if Exif Orientation 1 is chosen. This means 
that, without any kind of rotation, images displayed by other analysis programs may appear in the 
wrong orientation.  
 
To index the correct cameras, one can use the maps included below. 
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For EXIF Orientation 8 (Upright Kestrel) 

 
Fig 91: EXIF orientation 8 example. 

 
To use these indices in code, for example, if we want the image from wells C3, C4, D3, D4 from the Exif 
Orientation 8 dataset, we choose the micro camera index (1, 2) as shown in the figure above (Fig 91). 
    >>> from owl import mcam_data 
    >>> from matplotlib import pyplot as plt 
    >>> dataset = mcam_data.load(‘/path/to/dataset.nc’) 
    >>> image = dataset.image[1, 2].data 
    >>> plt.imshow(image) 
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For EXIF Orientation 7 (Inverted Kestrel)​

 
Fig 92:  EXIF orientation 7 example. 

 

To use these indices in code, for example, if we want the image from wells C3, C4, D3, D4 from the Exif 
Orientation 7 dataset, we choose the micro camera index (4, 2) as shown in the figure above (Fig 92). 
    >>> from owl import mcam_data 
    >>> from matplotlib import pyplot as plt 
    >>> dataset = mcam_data.load(‘/path/to/dataset.nc’) 
    >>> image = dataset.image[4, 2].data 
    >>> plt.imshow(image) 

Other Questions 
 
If you have any other questions regarding the MCAM, please contact help@ramonaoptics.com. 
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Troubleshooting Guide 

Did Not Detect MCAM 

 
Fig 93: Example “Error opening MCAM” pop up. 

 

This is very likely due to the MCAM being powered off. Please verify the following 
●​ The MCAM is connected to AC power. 
●​ Verify that the power switch is in the on position. 
●​ If both the above are true, the MCAM indicator light should be active. 

Once everything is verified to be connected try connecting to the MCAM again. 
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Did not detect a subcomponent 

 
Fig 94: Example “Error opening MCAM” pop up. 

 
Error messages like the one above are typical when the connection is loose between the USB cable 
connecting the computer and the MCAM (Fig 94). Ensure that the USB cable is connected to both the 
provided desktop computer, and the MCAM. 
 
If the error persists, verify that the options in the Menu: Advanced � Additional Settings  �  
Subcomponents. Verify that the customization settings match what the Ramona Team has 
communicated with you at the time of delivery. 

Limited Recording Duration 
 
Symptoms: The video acquisition GUI does not allow you to record for the desired duration (Fig 95). 
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Fig 95: GUI recording time limit exceeded due to high resolution. 

The possible causes for this are: 
1.​ The resolution of the system is too large for the desired recording. 

a.​ Try changing the resolution of the system on the upper right hand side. 
i.​ Selecting "High Frame Rate" will enable the longest recordings. 

ii.​ Selecting "Standard (bin x2)" will enable a good compromise between the 
highest resolution spatial settings and the highest achievable frame rate. 

iii.​ Selecting "High Resolution" maximizes spatial resolution at the expense of 
recording duration. 

b.​ Note the system always starts in "High Resolution" Mode. 
2.​ The recording duration must be done in "Extended Acquisition" mode (Fig 96). 
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Fig 96: “Extended Acquisition” mode activated on “Acquire Video” panel. 

a.​ The extended acquisition mode enables recording video directly to the SSD of the 
MCAM. 

b.​ The appropriate storage directory for recording 
i.​ This is setup by your Ramona Optics team to be 

/MCAM_data 

Cold Boot 
 
The following procedure is one that will force a cold boot to occur. This is the slowest, but most 
reliable boot up procedure. 

1.​ Ensure that your computer is off. 
a.​ To ensure it is really off, power down the computer, and remove the power cable from 

the computer. 
b.​ Keep the cable unplugged for 30 seconds (no joke, please wait). 
c.​ Plug the power cable back into the computer. 

2.​ Ensure that the MCAM is off (switch on the right hand side). 
3.​ Turn on the MCAM (not the Computer). 
4.​ Wait 30 seconds. 
5.​ Turn on the Computer. 
6.​ Open the MCAM GUI and open the MCAM. 

The connection issues should be resolved. 
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Connection issues 
 
Common error messages that may appear when connecting to the are divided into three: 

1.​ Connecting to the Multi Camera Array 
2.​ Connecting to the Illumination Modules 
3.​ Connecting to the motion subsystem 

Ensuring a good connection to the Multi Camera Array 
 

 
Fig 97: Error pop up indicating connection issues. 

This error message typically describes a missing connection from the MCAM body to the computer (Fig 
97). To fix this issue, please ensure that the: 

1.​ MCAM is powered on. The indicator light on the side of the MCAM should be lit to indicate that 
the system is powered on. 

2.​ The Power on sequence of the system was followed. 
If your issue is still not resolved, please do not hesitate to contact your Ramona Optics representative 
or contact us by email at help@ramonaoptics.com 

Fluorescence Illumination Modules Turned Off or Not 
Turning On 
 
If the fluorescence LEDs turn off unexpectedly or do not turn on when enabled, it is likely a result of 
overheating.  When driven for long periods of time, and especially at higher power levels, the LEDs 
heat up quite a bit.  For the safety of the user and the hardware, over-temperature protection circuits 
are in place to automatically turn off the LEDs when they reach 70 °C.  To recover from an 
over-temperature shutdown event: 

1.​ Disable Fluorescence in the GUI by clicking the switch below the Enabled label under the 
Illumination Settings (Fig 98). 
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Fig 98: Fluorescent light switch when lights are off. 

2.​ Wait for the LEDs to cool down.  The temperature of the fluorescence LEDs should reach room 
temperature in about 15 minutes. 

3.​ When you are ready to use the fluorescence modules again, re-enable Fluorescence in the GUI 
by clicking on the switch below the Enabled label again (Fig 99). 

 
Fig 99: Fluorescent light switch when lights are on. 
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